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1  Introduction                    
 

1-1  Code and Manual 
 
For a list of recent code changes and additions in this Build please see 

the Revision History towards the end of this document. Each release 

has a ‘Build’ number associated with it which you will see reported in 

‘About’ on the Help menu.  

 

Please do read the ‘Geoplot 4.0 Overview’ and subsequent sections 

below to avoid trying to use the few facilities that are not yet 

completed or are restricted – such items are highlighted in red. Apart 

from the few items highlighted in red, this code represents the 

completed version 4.0.  

 

These interim instructions are principally aimed at those familiar with 

Geoplot 3.0 and previous Geoplot 4.0 builds. If you are new to 

Geoplot then you will benefit from following the tutorial in the 

Geoplot 3.0 manual, Chapter 3, since this will give you an 

appreciation of the structure of Geoplot 4.0 – see ‘Running Geoplot 

4.0’. New Users, below. 

 

Help is available in the form of this manual, a Help Panel, Summary 

PDF sheets and Help buttons found on all forms. Clicking on a form 

help button  will either display a small panel with further 

information or will display a PDF file in your PDF reader. Please see 

Help in ‘Running Geoplot 4.0’ below for more detailed information. 

 
1-2  Code Availability 
 
Code and documentation are available from either the website or a Dropbox link emailed to you. This comprises (a) these 

instructions, (b) a full installer ‘Geoplot_4_Setup_xxxx.exe’ where xxxx is the build number, (c) other PDF documents and (d) 

latest Geoplot 4.0 data sheet. If you are a new user, then install the new program. If have previously installed Geoplot 4.0 then, 

since the options file formats will have changed, you must uninstall the old code first and then install this latest build. This will 

remove Scratchpad.txt, along with HelpGradiometer.txt, HelpMagnetometer.txt and HelpResistance.txt. The latter 3 files may 

have been modified by course tutors for their students and/or Scratchpad.txt may contain notes of work in progress. So, if 

you wish to preserve any of these files for the latest installation, please make copies and then paste them back over the 

newly installed versions. 

 

If this is the first copy you have received, then you may also have received a separate Dropbox link to update your dongle if it is 

not already configured to run Geoplot 4.0 (only dongles with numbers equal to or later than GP151286 are able to run Geoplot 

4.0 without requiring an update). Refer to the section below to update your dongle and then go to the section after for 

instructions for full program installation.  

 
1-3  Operating System and PC Text Size Setting 
 
This code will run on Windows XP, Vista, 7, 8, 8.1, 10 and 11, 32 bits or 64 bits. Touch screens can be used. 

 

Please note that the forms and code are designed for use on PC’s with Normal/Smaller (100%) resolution/text. Windows 10 

allows you to adjust resolution/text size to suit your preference whilst preserving the intended Geoplot 4.0 form design. 

However, if you choose to use larger fonts/text (125% or 150%) with XP, 7, 8 or 8.1 then the form design layout will not be 

correct in some cases: some controls may be put in the wrong place and there may not be room in text boxes for all text in some 

cases. The effect will be different on XP, 7 and 8.  

 

Some forms require you to set ‘Windows Screen Scaling (%)’ according to the PC Text Size setting to operate correctly. These are 

associated with screen saves: ‘Save Palette and Scale Image’, ‘Desktop Image Save / Print’ and ‘Save Palette and Scale Image’. 

 
1-4  Dongle Update 
 
Geoplot 4.0 will only work with the blue coloured Matrix USB dongles. However, these dongles first need to be 

updated/reprogrammed to work with Geoplot 4.0 if their serial number is smaller than GP151286. Once we know the serial 

number of your dongle, and you have purchased an upgrade, we can send you a DropBox link to a small executable program. 



Plug the dongle into a USB port, run the executable and this will update the dongle (the executable will only work with that 

specific dongle serial number). The dongle will then allow you to run either Geoplot 3.0 or Geoplot 4.0. Dongles with numbers 

equal to or later than GP151286 are able to run Geoplot 4.0 directly without requiring an update. 

 

1-5  Installation Preparation - .NET Framework 
 
Geoplot 4.0 is a 32 bit program that requires the Microsoft NET 2.0 and 3.5 frameworks in order to run. Note that these are 

separate from the NET 4.0 and NET 4.5 frameworks typically found on modern computers – 2.0 and 3.5 will most likely not be 

already installed. The NET 2.0 and 3.5 frameworks can typically be found in C:\Windows\Microsoft.NET\Framework as 

v2.0.xxxxx and v3.5 where xxxxx depends on the update installed. If 2.0 and 3.5 are not installed then, when you try to run 

Geoplot 4.0 (see below), you will see an error message saying NET 2.0 or NET 3.5 is not installed. To cater for such situations the 

Geoplot 4.0 installer places a small program called dotNetFx35setup.exe in the c:\gp400\NET_Framework_Web_Installer 

directory that can be run to download and install NET frameworks 2.0 and 3.5 from the Microsoft website (it will also install 1.0, 

1.1 and 3.0 frameworks at the same time). The framework download is 60Mb and will take some time to download and install – 

this may take 5 to 15 minutes to complete depending on the speed of your internet connection and computer. 

 
1-6  Program Installation 
 

1  Updating an existing Geoplot 4 installation 

It is very important that you uninstall any existing beta version of Geoplot 4.0 first. Note that this will remove Scratchpad.txt, 

along with HelpGradiometer.txt, HelpMagnetometer.txt and HelpResistance.txt. The latter 3 files may have been modified by 

course tutors for their students and/or Scratchpad.txt may contain notes of work in progress. So, if you wish to preserve any 

of these files for the latest installation, please make copies and then paste them back over the newly installed versions. 

 

Use the Uninstall program placed on the start menu alongside the Run Geoplot 4.0 item or if you are using Windows 10 then use 

the Windows uninstaller. After uninstallation check in C:\GP400\Options to see if there is a residual file called 

RecentFilePaths.txt – if there is then please delete this file to avoid problems with Geoplot 4.0. In future, the uninstaller 

should remove this file. If you see an MRUFiles.txt file present, then this may be left in place since this is a list of recent files that 

you have opened and will be displayed at the bottom of the File menu. 

  

After uninstallation run the ‘Geoplot_4-0_Setup_xxxx.exe’ program (where xxxx refers to the Build Number) to install Geoplot 

4.0 on your system. This will install all necessary files, some demo data files and macros, along with shortcuts on the Start button 

and the Desktop. 

 

2  Fresh Installation 

If you are installing on Windows 11 then you will need to switch off S mode before installation. Run the ‘Geoplot_4-

0_Setup_xxxx.exe’ program (where xxxx refers to the Build Number) to install Geoplot 4.0 on your system. This will install all 

necessary files, some demo data files and macros, along with shortcuts on the Start button and the Desktop. 

 

3  Installation Problems 

If you encounter difficulties in getting Geoplot to install correctly, consider the effect of Anti-Virus or Malware programs – for 

example McAfee or MalwareBytes can sometimes quarantine installation files. In this case you do not need to disable the virus 

checker in its entirety, just exclude GP400mx.exe from the real time scanning. Under ‘Change settings’, ‘Real Time Scanning’, 

just add GP400mx.exe to the list of excluded files. Then it leaves it alone and does not quarantine it every time it is run. You may 

also need to reboot the laptop or PC after installation. 

 
 



2  Running Geoplot 4.0 
 

2-1  Introduction 
 

Click on the Start Menu or Desktop short-cut to run Geoplot 4.0. A splash screen will be displayed 

and then the main program will open up with a central grey area and most of the surrounding 

toolbar items greyed out. A yellow message form will appear and behind that a Help panel. See 

section 1-5, above, if you see an error message saying NET 2.0 or NET 3.5 is not installed. 
 
2-2  Region and Language Settings 
 
If you are using a European operating system then it is very important to ensure the Region and Language setting (Formats, 

Additional Settings…, Numbers) in Control Panel is set so that decimal separator is Decimal Symbol and not a comma. In 

addition, Digit Grouping Symbol should be comma. If these changes are not made then parts of Geoplot 4.0 will not function 

correctly, especially Import. There is a yellow reminder form when you first run Geoplot 4.0 – see right which you can stop from 

reappearing by ticking the checkbox. 

 
2-3  Help   
 
General help is available in the form of a Help Panel, Manual and other PDF files, plus 

individual Help PDF’s for all Geoplot 4 functions. In addition, floating Help forms are 

available that introduce the basics of processing Resistance, Gradiometer and 

Magnetometer data – see section 13 for details.  

The Help Panel, below left, is accessed by clicking on the  button on the horizontal 

toolbar or Help menu, View Help Panel or by pressing F1. It will be of use to new users and 

can be resized and positioned in the corner of the screen for reference. The panel has four tabs which cover the essentials: 

Environment, Screen Details, Overview and File Types. It contains the images that follow in the next section. If you want to show 

the panel again, click on the question mark on the horizontal toolbar. You can stop the form appearing again by ticking the ‘Do 

not show…’ checkbox or go to Options, Environment, General. 

PDF Help documents can be accessed by clicking on the  button on the horizontal toolbar or by selecting Help menu and 

‘View Manual and other Help PDF Files’ or by pressing F2 and this will display the form shown below, right. You can select a 

number of these, or all of them, and then click OK to open them up in your PDF reader. 

 

             
            

There are also individual help buttons   on Geoplot forms, including Edit, Process and Tools, which you can click on to show 

either another descriptive form or launch a PDF document in your PDF reader.  

 
2-4  New Users  
 
If you are new to Geoplot then you also may benefit from following the tutorial in the Geoplot 3.0 manual since this will give you 

a good idea of the structure of Geoplot 4.0. There will be slight differences, but it should give you a basic grasp of the underlying 

concepts of grid, composite and master grid and processing. You will not be able to follow all the tutorial since some features 

such as Publish are not included in Geoplot 4.0. The manual is installed with Geoplot 4.0, accessible as described above. 

 
2-5  Run Simultaneous copies of Geoplot 
 
Note that you can have several copies of Geoplot 4.0 running at the same time. This can be useful if you want to compare 

different data sets side by side. 



3  Geoplot 4.0 Overview 
 
 

 
 

3-1  Introduction 
 
The latest Geoplot 4.0 data sheet gives a summary of Geoplot 4.0, available by clicking on the ‘PDF Manual’ button on the 

General Toolbar and selecting the data sheet. Above is a screenshot of the default environment with gradiometer data loaded – 

if you have a large LCD screen then other buttons may be visible on the General Toolbar and the Process and Tools Toolbar. The 

main elements of Geoplot 4.0 are: Menu Bar, General Toolbar, Horizontal Process and Tools Toolbar, Right Hand Control Panel 

(comprising Graphics Control Panel, Data Information and Latest History), Status Bar and Vertical Process and Tools Toolbars 

(wide and narrow versions). In the view above the Horizontal Process and Tools Toolbar (a copy of the vertical version) is not 

shown – see View menu for ways you can customise the layout. There are four views of the currently loaded data available: 

graphics, data, history and file details (images on the right); you can swop between these using either the View menu, function 

keys F5, F6, F7, F8 or cycle back and forward between them using the orange triangular buttons at the right end of the General 

toolbar. Note that this build adds some extra functions not shown in this section’s graphics. 

 

The right hand (RH) panel controls many functions, e.g. fast selection of shade plot palettes, change of plot type, rotation of 

data, etc.; you still have access to the Geoplot 3.0 style menu system as well. The panel also displays data information and latest 

history. Forms are designed to run on all screen sizes, from Netbooks through to desktops and they remember their last position 

so you can arrange the work area to your preference.  

 

A more detailed view is shown below, giving the location of many toolbar buttons and examples of the different graphics views 

available. It also shows the range of palettes available. As the mouse is moved over a graphics plot the data value at that point is 

reported on the left-hand side of the Status Bar, along with its coordinates in units of metres and readings. If a process block is 

selected then its dimensions are reported in the bottom right-hand corner of the Status Bar, along with its status i.e. Inclusive, 

Exclusive and whether it has been “snapped to grid” or not. Note that this build adds some extra toolbar buttons not shown in 

this section’s graphics. 

 

Many of the colour schemes and graphics components can be changed in either the Environment or Graphics options. When 

colours in Graphics Options are changed, clicking the Apply button immediately updates the display.  

 

The Options Menu, described in more detail later, allows you to determine how Geoplot 4.0 is set up and operates. One of the 

most important of these is the COM port settings for download and you should explore and make sure that this setting, at least, 



is correct at an early stage. This is done in the Environment Options, Download Tab, where you can set default COM ports 

separately for the RM85 and other instruments. 

 

Throughout Geoplot 4.0 you will find buttons with a red ‘O’ in the centre – these remind you there are Options associated with 

this part of Geoplot 4.0 and if you click the button it takes you directly to the appropriate Options tab. 

 

If Geoplot 4 behaves in an unexpected manner at any stage, then it could be the Options files have become corrupted or are 

not compatible with a later build. To restore correct Options files, exit Geoplot 4.0 and delete the existing files in the Options 

directory C:\GP400\Options. On restarting Geoplot 4.0 will offer to create new default options files – these will be saved 

when you next exit Geoplot 4.0. 

 
 

 
 
 
 
3-2  Basic Concepts 
 
An overview of how data is organised, structured and referenced within Geoplot 4.0 is shown in the Help panel – image below. 

 

In summary, a site is subdivided into smaller areas called grids. Data is collected by surveying each grid in turn. As shown in the 

panel below, for each grid we specify: (a) grid length and sample interval where these are measured in the X direction, (b) grid 

width and traverse interval where these are measured in the Y direction. The normal direction of the first traverse is clockwise. 

 

Once several grids have been surveyed these are downloaded into Geoplot 4.0 as separate files. Next, a MasterGrid is defined 

which is a template that specifies how all the grids fit relative to one another – the grids are still separate files. The individual 

grid files are usually combined into one file called a composite for further data manipulation. 

 

Dummy readings are used where an actual reading cannot be recorded. The default value set in Options, Environment, Data tab 

is 2047.5 and any reading with this value is ignored by statistics, editing, processing and graphics – by default it is shown as a 

turquoise colour in graphics (see above) but this colour can be changed in Graphics Options, General tab. Avoid using zero as a 

dummy reading, especially when working with gradiometer data. 

 



There are some functions that can be applied to grid files, generally found in the Tools menu and are mainly aimed at correcting 

errors made during data collection or download. The main processing functions in the Process menu can only be applied to 

composites, along with some Tools. If a raw grid file is edited, then it must be saved with a new name to preserve the raw data.  

 

 
 
 
3-3  View Menu 
 

There are four different views of the data available: Graphics, Data, History, and File 

Details. You can cycle through the views by clicking on the left and right orange 

arrows in the top right-hand corner. Alternatively, you can use this menu or press 

the F5, F6, F7 or F8 functions keys to select a view.  

 

The View menu is used to control which of the following items are visible: two 

vertical and one horizontal Process/Tools Toolbars, General Toolbar, Right Hand 

Control Panel, Latest History (floating) and Scratchpad. Preferences for these and 

other View items can be set in Options, General tab. 

 

The menu can also be used to turn on and off Grid Lines , Grid Numbers , Grid 

File Names  and User Grid Lines , though these can also be controlled via the 

F9, F10, F11 or F12 function keys or usually more conveniently from the General 

Toolbar at the top. 

 

1  Grid Numbers, Grid File Names, User Grid       

Grid numbers are used by process functions to refer to a particular grid within a 

composite and are numbered from left to right, top to bottom, regardless of original 

file names – see image below where the numbering goes from 1 to 25. Grid File 

Names, if available from a MasterGrid, are displayed just above the Grid numbers – 

see image below. A user grid can be used to add positional information of features 

and can be tailored to user requirements in Graphics Options, Grid Guides. The 

image below shows orange crosses, but the colour and format can be changed to 

lines, vertical and/or horizontal. 



 

The View menu offers access to graphics control such as zooming or panning a graphics image though again it is usually more 

convenient to access them from the General Toolbar at the top or use Ctrl key combinations. 

 

 
 
2  Scratchpad     

A ScratchPad form can be used to make notes during a Geoplot session - the 

form can be resized and repositioned. Any text is saved when Geoplot is 

exited and is then reloaded when the program restarts to act as a reminder. 

Tab and Enter may be used. Closing or cancelling the form does not lose any 

information - use the Clear button to delete all the text. You can use the 'Add 

Text to Comp Notes' button to save the text with composite file notes.  

 

Examples of use include (a) noting block statistics - click on a single Statistics 

Report value to place it in the Clipboard then paste into the Scratchpad or 

click on the ‘Copy Summary to Clipboard’ button to collect all values. ), (b) 

noting of block coordinates ready for entering into Cut and Combine - values 

can be copied and pasted, (c) the name of the current file loaded can be 

copied and pasted here from the menu bar, (d) recording a summary of all 

the Data Information from the RH Control Panel using the ‘I’ button (to the 

right of ‘Mean’) to first place the information on the clipboard. Reminders for 

present or future processing steps can be recorded and Process History can 

be copied here.  

 

Any ScratchPad text can be pasted into the Composite Notes area if enabled - for example recording the logic behind specific 

steps taken to correct unusual survey defects. 

 

Please see the Process Menu, Statistics Report, for further notes on copying a statistics summary to the clipboard using the 

‘Copy Summary to Clipboard’ button. You can also ‘Copy Data Information to Clipboard’ using this button   in the RH control 

panel. 



4  Graphics View (F5) and Graphics Menu 
 

4-1  Overview 
 
There are two main graphics views of the data available: Shade Plot and Trace Plot. The principal way to access the different 

views is to use the RH Control Panel to cycle through the Shade and Trace views, five in total, by clicking on the left and right 

black arrows  in the top right-hand corner of the RH control panel. The plotting parameter entry panels will change 

according to plot type. An alternative way to access the different graphics views is to use the two buttons on the general 

toolbar, and  or use the Graphics Menu, resulting in the display of the appropriate plotting parameter form – see images 

below. There are three styles of Shade plot: Shade-Clip, Shade-Relief, Shade-Compress and two styles of Trace plot: Trace and 

Trace-Clip.  

 
      Shade Plot (default views of Clip, Relief, Compress)  Trace Plot (default views of Trace, Trace-Clip) 

 

     
 

 

     
 

 

 



The Shade and Trace plotting parameter forms are 

shown to the right. These will track the settings on 

the RH panel and vice-versa. However, for Relief 

plots (see below) the RH panel will offer much 

more interactive flexibility so, in general, we 

recommend using the RH panel most of the time. 

 

Whenever you change any of the RH control panel 

plotting parameters the New Plot button 

will turn red indicating you need to 

either click it or simply press Enter to refresh the 

display. If you want to change the plotting 

parameters back to the default values set in 

Options press the ‘D’ button located in each 

graphics control panel.  

 

4-2  Details 
 

1  Shade Plots    

Shade plots can have between 2 and 256 different shades of grey or colour (palettes) to 

represent the data. Each Shade view can have a palette independent of the others. The 

three shade plot types can be either selected using the left and right arrows in the RH 

Control Panel or via the radio buttons on the shade plot form. Depending on which 

type is selected, the parameters offered will change. The colour of the dummy areas is 

set in Graphics Options and is by default a pale blue as shown above. A ‘T’ button in the 

RH Control Panel allows you to turn dummy areas transparent which can be useful 

when saving an image of the plot for publishing (see later). When ‘T’ is active it turns 

blue and dummy areas show as white.  

 
2  Shade – Clip    

Shade-Clip plots are the most commonly used and as such are the default view. Plotting 

parameters Minimum and Maximum set the range of data that will be displayed as 

different shades – any data above and below these values will be clipped. The values 

can be either entered as absolute values or Standard Deviation (SD), values by setting 

Units. SD values are based on the statistics of the data set and is useful for an initial 

look at data, especially resistance data. Absolute values are more commonly used for 

gradiometer data. Contrast controls the linearity of the shade gradation. The palettes 

can be cycled forwards , backwards , or inverted  using the appropriate 

buttons on the general toolbar or by using the RH control panel. A specific palette can 

be selected using the select button – see below for further information. The palettes 

provided cater for presentation, data analysis and interpretation.  

 

3  Shade – Relief   

Shade Relief plots present an almost photographic style quality by simulating an 

artificial sun shining over an undulating surface. They are particularly effective at 

removing background resistance variations. Plotting parameters vary the effect of the 

artificial sun by changing its Direction and Elevation; there is also a Scaling parameter 

which acts as a contrast control. Example composite data for experimenting with Relief 

plots is located in the GHerb directory (file: Azi). Relief plots are usually better with 

smaller sampling intervals e.g. SI = TI = 0.25m. Plotting parameters can be adjusted on 

the far RH panel and then click New Plot (or hit Enter) for a graphics update. 

Alternatively, you can click either the left or right Direction arrow button which will 

then step through the directions, one-click at a time, clockwise or anticlockwise, and 

update the plot at the same time. (Tip: if you have previously used one of these buttons 

and then keep the Enter key pressed then the direction and plot will be rapidly updated 

until you release the key). You can also click any of the direction arrows on the left-

hand part of the panel to select an individual direction. Finally, you can tick Animate 

Illumination, and the plot will then cycle through all the directions clockwise – adjust 

the rate by clicking on the slider bar. Whilst the animation is in progress you can alter 

scaling or elevation on the fly. Scaling works with positive, negative, zero. You can also 

change the palette using the horizontal toolbar buttons or invert the palette at the 

same time the animation is in progress. Note that the illumination angle is out by 90 degrees but will be fixed in a later build. 

  Shade and Trace Plotting parameter forms 



4  Shade – Compress    
Shade-Compress plots have a similar effect on the data to the Process Tool Compress when it is used with Arc Tangent 

compression, though of course the data remains unchanged in this case. In the graphics case Brightness is equivalent to Scaling 

Factor and Contrast is equivalent to Pre-Multiply Factor. See the graphical representation for the transfer function in the Process 

Reference Chapter. It provides a way of viewing low amplitude data to be seen in the presence of large noise spikes. 

 

5  Trace Plot and Trace-Clip Plot    

Trace plots represent data by a series of line graphs stacked vertically. The two trace 

plot types, ‘Trace’ and ‘Trace-Clip’, can be either selected using the left and right 

arrows in the RH Control Panel or by setting Clip to ‘On’ or ‘Off ‘in the trace plot 

plotting parameter form. Hidden Line can be set to ‘On’ or ‘Off ’and determines 

whether a line in the foreground blocks any lines appearing behind it.  

 

The data may be viewed from all four sides by changing either the View drop-don box 

in the far-right hand panel or by clicking on one of the four View direction arrows in the 

left hand panel. Trace Resolution can be entered as either absolute or Standard 

Deviation (SD) values with SD values being most useful for an initial look at the data. 

The data set mean is subtracted for trace plots so that non-bipolar data (EG resistance) 

appears centrally. The trace angles can be adjusted to give a 3D style view by changing 

X-Disp. And Y Exp. Please note that at present, when you set a non-zero X Displacement 

value and set Hidden Line to on, then the shadow cast by any spikes will not be 

correctly placed.  

 

6  Graphics Control Buttons 

There is a line of four buttons under the four View Direction arrows that control various 

aspects of the display:  

 

‘D’ allows you to quickly changes settings to the default values.  

 

‘T’ allows you to turn background transparency on and off, used when saving an image 

of the plot. Transparent images can be overlain on corresponding shade plots in 

publishing documents. When ‘T’ is active it turns blue. 

 

‘S’ allows you to show any existing Shade Clip plot in the background, underneath the 

traces. To change the shade plot, navigate back to the Shade plot view, change the 

plotting parameters and then return to the Trace plot view. 

 

 
 
‘L’, the 4th button, allows the colour of the lines to be changed. The button changes colour to reflect Trace line colour – in the 

above example form it shows as solid black since that is the line colour. It can also be set in Graphics Options. 

 

Dummy data is not usually shown as a line but if ‘Dummy Line On’ is checked then dummy data will appear as horizontal lines, 

red in colour by default (the colour can be changed in Options).  

 



‘Trace-Clip’ plots adds Minimum and Maximum clipping values to the RH Control Panel, entered as absolute values, which are 

centred about the mean. They are usually used to suppress noise spikes in resistance data or ferrous spikes in gradiometer data. 

 

7  Grid Lines, Grid Numbers, Grid File Names, User Grid        

Grid Lines, Grid Numbers, Grid File Names and a User grid, all accessible from the View menu or general toolbar, can be 

displayed. Grid numbers and grid filenames can now have a white background, set in Graphics Options. Grid filenames position 

can now be offset upwards by one line, so it does not overlap grid numbers – set in Graphics Options. A warning that grid names 

will be misleading is given if data is rotated and grid names are displayed – the message disappears if data is subsequently 

rotated back or round to the original position.  

 

8  Save Image     

Images can be saved by clicking on the Save Graphic Image button on the general toolbar or from the Graphics Menu. Images 

can be saved as jpg, bmp, png, tif and gif for use in publications - this includes any off-screen areas, so the image can be saved at 

high magnification / resolution. Transparency buttons, ‘T’, have been added to the RH control panel so that when an image is 

saved dummy readings can be saved as transparent areas for Shade plots. When ‘T’ is active it turns blue and dummy areas 

show as white. For Trace plots, when transparency is on, trace lines will be saved on a transparent background; when off the 

background will be white. Transparent images can only be saved as png or tif files since these support transparency whereas jpg, 

bmp and gif do not. 

 

Tip: Quick filename extraction. You can single click on the text box (on the right of the menu bar) that shows the full file path of 

the current file loaded and this operation copies just the filename to the clipboard, discarding the other parts; the text box will 

have a green background for half a second to indicate this has happened.  

 
This can be very useful for Save Image and Save Histogram when the file name is complex, e.g. “R_HPF10x10_ZMT_LPF1x1x6” 

and you wish to incorporate that in the image name. Normal Copy and Paste can also be used but the above method extracts 

the filename faster. 

 

9  Save and/or Print Desktop Image     

An image of the desktop can be either saved and/or printed by clicking on the ‘Save and/or 

Print Desktop Image’ button on the general toolbar or from the Graphics Menu. Images can be 

saved as jpg, bmp, png, tif and gif. A form appears that allows you to choose to save and/or 

print. In your Windows settings, if you are using a size of text. other than 100% (Windows 

Settings, “Scale and layout”), then set a matching size on the form so that the desktop image is 

correctly saved/printed. You can save this setting in Options for future use. When printing, set 

the paper to Portrait and A4 or letter and Geoplot will rotate the image to fit. 

 

10  Save Histogram     

Histograms can be saved by clicking on the Save Histogram button just to the right of the histogram displayed on the RH panel or 

from the Graphics Menu. Histograms can be saved as jpg, bmp, png, tif and gif for use in publications. 

 

11 Save Palette and Scale    

You can save an image of the palette and scale shown in the Right-Hand Control Panel for inclusion 

in a survey report. Options are provided to save just the palette and scale, or additionally Units, the 

North symbol, the Histogram, a border for the histogram and choice of histogram colours. The 

defaults are shown to the right but can be changed in Graphics Options. 

 

Saving the image can be selected either from the green camera symbol next to palette in the Right-

Hand Control Panel or from the Graphics menu. When selected, a “Save Palette and Scale Image” 

form appears where you can make selections for what you would like to save. The first item, 

Windows Screen Scaling, refers to your Windows settings. If you are using a size of text. other than 

100% (Windows Settings, “Scale and layout”), then set a matching size on this form so that the 

image is correctly saved. You can save this setting in Graphics Options for future use. “Save Palette 

and Scale” is permanently selected but you can change the other items to include.  

 

When you click OK, a preview of what the palette and options will look like will appear at the top of 

the Right-Hand Control Panel, temporarily replacing the original palette etc. At the same time a save 

image form will appear where you select the image type from .jpg, .bmp, .png, .gif, or .tif. Select the 

save location, give the image a name and save, or if not satisfied then press Cancel to start the 

process again, this time selecting the elements you want. There is a range of colours that the 



histogram can be drawn in apart from black: Black, Chocolate, Salmon, Dark Red, Dark Green, Dark Cyan, Steel Blue, Royal Blue, 

Purple. 

 

12  Print    

Shade and Trace plots can be printed out either as scaled plots (e.g. 1:1000) or as sized plots (e.g. x2); scale can be selected from 

a drop down list or set to any specific value. Optionally File Information, Statistics and History can be printed out with the plot. 

Trace plots additionally have a Quality setting, Coarse, Medium and Fine, corresponding to the view seen at x1, x2 and x4 

respectively. Apply caution when printing scaled Trace plots since, depending on the data set, chosen scale and dpi, some small 

horizontal sections of the image may be missing; when printed using sized plots Trace plots are always complete. If PDFCreator 

is used as the printer, then the graphics can be saved as PDF files or as graphics files such as .png where very high resolutions 

can be set, e.g. 1200dpi. 

 

13  Zoom and Pan           

You can Zoom-In on a graphics at the centre point or Zoom-Out at the centre point. Clicking on Pan allows you to drag shade and 

trace images around the screen with the mouse – click Pan once to enable, click Pan again to disable (status is shown by a 

change in background colour). However, Zoom-In To a Point and Zoom-Out From a Point are not properly working yet – for now 

they are disabled; instead use the normal zoom in / out to the level you require and then Pan. Note that the block selection 

button and menu item is disabled whilst Pan is enabled – disabling Pan re-enables block selection.  

 

14  Border    

There is a Display Border button on the general toolbar to control whether this is shown or not around a plot, and the colour can 

be set in Graphics Options.   

 

15  Palettes 

There are 66 pre-set palettes available; at present you 

cannot design your own. Palettes can be changed by either 

using the Select button in the RH control panel, using the 

Graphics menu shade form or using the palette buttons on 

the general toolbar (see next). If you choose a palette from 

the form displayed using the Select button, then you can 

either just click OK or double click on a palette. In the 

former case only the control panel palette will update giving 

you chance to change the other parameters as well. If you 

double click, then a new plot will be made immediately 

using the new palette. The last 26 palettes are intended for 

simplifying a plot and then saving as a coloured image to be 

subsequently used as a layer in an Animation sequence – 

see below. The 2 palettes before that, when used with 

appropriate plotting parameters, can display data at 1SD, 

2SD and 3SD significance compared to the SD of noise 

measured in a quiet area. 

 

16  Palette Invert       Previous Palette       Next Palette    

A cluster of three button on the general toolbar allow you to quickly change the palette, either inverting the current palette or 

selecting the previous or next one from the sequence shown above. The name and invert status will change on the RH Control 

Panel to reflect this. 

 

17  Graphics Block Selection 

We are not proposing to provide a Graphics block selection in this first release. In the meantime, please save an image and use a 

third party graphics program to extract the part you require. 

 
 
 
 
 
 
 
 
 
 



4-3  Interactive Interpretation using Overlays and Animation     

 
An Animation and Overlay Editor, 

right, provides archaeological feature 

analysis and interpretation based on 

multi-method geophysical survey. The 

Animation component is primarily in 

support of GPR time slice data though 

it can also be used to compare 

different survey methods, such as 

resistance, magnetics and EM. The 

Overlay component supports static 

data. The animation can be paused at 

any convenient point, run forwards or 

backwards either continuously or in 

single steps. The opacity of any 

selected overlay image can be 

interactively adjusted to help in 

understanding data sets, their spatial 

relationship, complementary nature 

and to develop an interpretation from 

a variety of sources - including 

resistance, magnetics, GPR, LiDAR, 

topography, EM etc. Images can be 

.jpg, .bmp, .png, .gif, or .tif in any 

combination but must cover the same 

survey area. Up to 9 images can be 

selected for overlay on the animation 

and each image can be turned on or off and its ordering position relative to other layers changed.  

All pre-processing and graphics creation can be done within Geoplot 4.0 using the Processing and Save Graphic Image capability. 

The display form supports transparency so images saved as .png or .tif that have transparent areas defined will show layers 

behind. The Display form can be resized to suit user preference. 

 

Opaque layers are usually selected first as bottom layers, followed by the animation; transparent layers are usually selected 

after the animation, towards the top. Add layers to the Image list on the left-hand side by using the Browse button. An image 

preview can be made by clicking on a file name. Highlight a file name and then add it as a layer by clicking on one of the Layer 

buttons in the Set Layers group box. If you have a few layers, then they can be inserted in one go by clicking on the Transfer 

Image List to Layers button. Once you have all the required layers clear the image list then browse and select the files you want 

to animate – they must be in the same directory as the layers. Files from this list can be added, inserted or deleted from the 

animation list on the right, either singly or in blocks of ascending or descending names. If you intend to add file names in blocks 

only, add only names to the left-hand list that will be part of the block. It can sometimes be useful to use both the ascending and 

descending buttons to create an animation list. Further images can be added to the Image list and can be individually selected 

for addition to the animation list. As soon as you click on any of the 

Add buttons this will create a layer after any other layers called 

‘Animation_Layer’. You can continue to add more animation files if 

you wish or further overlay layers after the ‘Animation Layer’, 

especially if they are transparent. If desired, an animation does not 

have to be created and just the Overlay Images can be used in the 

Display view or vice versa.  

 

Click ‘Display Animation and Layers’ to start the sequence. 

 
The animation display form allows you to control the speed of the 

animation by adjusting the Time Interval. The current file name is 

displayed at the top of the form and in a text box with a number to 

the right indicating its position in the list. If you pause an animation 

this allows the single step forward and back buttons either side of 

pause to be used. Animation can be resumed forward or backwards 

using the outer pair of buttons. Layers can be turned on or off using 

the checkboxes in Layer Control. Opacity of a layer can be 

controlled by adjusting either the number or slider. If a layer is 

high-lighted it can be moved to the Top or Bottom of the layer 



sequence using the Move buttons. Typically, bottom layers need a higher opacity. The form can be resized to suit the application 

– full screen if more than one person is viewing it or small to enable the eye to more easily pick out patterns. Default speed and 

opacities can be set in Graphics Options.  

 

The animation list, overlays and file location can be saved as an Animation .gan file. in the editor form for future recall. See the 

latest Geoplot 4.0 data sheet for examples of animation use. Example images from radar (55 layers), resistance and gradiometer 

for the Spanish Mission Settlement survey are provided with the Geoplot 4.0 installation for you to experiment with in the 

Import Image directory – see images to the left. Note that animation and overlay images must all be in the same directory. A 

button has been added to allow you to hide the Animation control panel and restore by pressing the Space Bar. 

 

  

 
 
The typical image size of the example data is about 25Kb. On some slower computers significantly larger sizes (e.g. 1Mb) may 

not load fast enough so will need to be reduced in size. You can either use your favourite graphics program to do this in a batch 

or a fast an easy way to do this is to use Outlook. In Windows Explorer select a group of files, right click and from the menu 

select Send To and then Mail Recipient. A form will appear offering to set the picture size of an outlook attachment – it does not 

affect the original image size. Choosing the default size of Medium will typically reduce a 2.5Mb file down to 25Kb (the total size 

of all the images summed together is shown in the form, not the individual reduced size). Click OK and an email will appear with 

all the images appearing as attachments in jpg form but reduced in size. Select all these and save to a new directory for use in 

the animation; you can then discard the email. 

 

On some networks or NAS drives, the images may not be fed through fast enough so you should then save the images you wish 

to work with on the local C drive. 

 

 

 
 
 
 



4-4  Image Threshold Tool    
 

An Image Threshold Tool allows you to extract more information from an image, usually a grey scale, by setting a threshold level 

above which image information is displayed using a chosen palette colour, whilst below that level that part of the image will be 

typically white. This tool is useful for applying to radar images and the thresholded image can be subsequently used in the 

Animation as an interpretation layer. It can be used to give false colour to grey images as well. The tool is found on the Graphic 

menu or on the top General Toolbar, next to Animation. 

 

 
 

Files for processing can be selected by using the Browse button and choosing filenames that will appear in the Image List box. 

When you click on a filename in the Image List, the image will be displayed in the Original Image box and its bit level is reported 

in the Pixel Format text box. The tool only works with 32 bit images which can be BMP, PNG or TIF. If an image is 24 bit then you 

can convert it to 32 bit by opening and saving it in Paint to create a 32 bit version. Click on Apply Threshold to process the image 

which will appear after a short time in the Threshold Image box. The form can be resized to fill the screen if you wish. 

 

The threshold level can be changed by either moving the Threshold slider to a new point or by changing the number that 

appears in a text box to the right of the slider, entering a value between 1 and 100. The Threshold Image is only updated once 

the mouse moving the slider is released whereas the Threshold Image starts updating as soon as the text value is changed. The 

background colour of the Threshold Image can be changed from the default white to one of three grey levels or black. Once a 

threshold has been applied, the threshold image can be saved, optionally with a transparent background if a white background 

is selected (even with original images which are BMP).  

 

There are a range of single colour palettes which can be selected using either the Select Palette button or by using the forward 

and backward buttons either side of the button. There are also a number of 5 band palettes which can be used to set 20%, 40%, 

60%, 80%, 100% levels above the threshold. In addition, if a 5 band palette is chosen, then a Contrast level of between 1 and 10 

can be set above the default of 1 which will compress the image range above the threshold and improve visibility of some 

features. You may need to adjust the threshold level when moving from single to banded palettes and vice versa. 

 

 



 

An example radar image can be found in c:\geoplot\import_image\Radar_Mala_Near_Surface_Slice\1.png. Examples of 

processing this are shown above and below. With your own data, you may have several images at different depths that show 

different features. You can use the Image Threshold tool to convert the information at each depth into different coloured 

threshold images and then overlay them in the Animation tool for presentation, possibly along with resistance and gradiometer 

data. 

 

 
 



5  Data View (F6) 
 

5-1  Overview 
 
The Data View has a small image of the data plus red rectangle which moves over the plot to show what area of data you are 

looking at. The view window size is adjustable: it can be set manually using the X and Y combo boxes or set to the source grid 

size if the data set is a composite by clicking on the checkbox. These preferences can be set in Options. Click on the four arrow 

buttons in the Control Panel to move the window over the data set. To enable editing tick the Edit Data check box – the text will 

turn green to signify editing is on – see image below. Highlight a data point to edit and either press Delete or Back-step to clear 

the existing data, or simply append new values. When you move away from the cell it will turn green to indicate it has been 

edited and the Latest History will update as well. If you leave a cell empty, it will be filled with a zero. An ‘Insert Dummy’ button 

is provided in the Right-Hand panel to ease dummy value entry where the cursor is, though you must move the cursor away 

from the cell to activate the entry.  

 

Any edits applied will not show in the panel image until data is saved and reloaded. If you apply a process function, then this will 

be reflected in the data values you see in Data View - the red navigation rectangle will be reset to the top left-hand corner after 

a process if applied whilst in Data View and the panel image will be updated. The data view cannot be printed. If you wish to 

have a printout of the data then please export as a spreadsheet, open in Excel and then print the spreadsheet. 

 

The data view cannot be printed. If you wish to have a print-out of the data then we suggest you export in spreadsheet format, 

open in Excel and then print from there. 

 
 

 



6  History View (F7) 
 
6-1  Overview 
 
The history view is updated whenever a function from Edit, Process, Tools or Macros is applied. There is a separator line that 

indicates which are saved and unsaved function applications – anything below the line is unsaved. The separator line is moved 

down once the new data is saved. A shorter version of this information is shown in the right-hand panel in Graphics view and 

also the floating Latest History form if activated. If you have Calculator displayed, then this may limit the amount of history that 

can be viewed on smaller screens; in that case use the floating form. Please note there is currently a bug with the RH panel 

history report – the text disappears off the bottom when the history list is very long; again use the floating History form if this 

happens. 

 

1  Latest History – Floating    

The ‘Latest History – Floating’ form is normally only visible in the Graphics view when activated; you can turn it on in other views 

if required. If you want it to always appear at start-up check the box in Options, Environment, General tab. The form can be 

resized to fit conveniently in your working area. 

 

2  Print    

The full history can be printed using the print button  also found on the File menu. This can be either to a real printer or 

PDFCreator (or similar) to obtain a PDF document. 

 

 

  
 
 
 
 
 
 



7  File Details View (F8) 
 

7-1  Overview  
 
The File Details view for grids gives 

comprehensive information about 

mapping parameters, instrument 

setup and statistics. The File Details 

view for composites likewise shows 

mapping parameters, 

instrumentation, statistics plus 

MasterGrid information. If a 

MasterGrid exists then details will be 

shown in this view, otherwise just a 

red label will advise it is missing. 

 

The File Details View also enables 

notes to be stored as a text file with 

each composite – click the ‘Edit 

Notes’ button to make entries in 

Composite Notes. These can be used 

to explain details and logic of data 

processing, site peculiarities, unusual 

aspects of the survey or background 

information etc. Scratchpad notes 

(see below) can also be added here. 

Geoplot 3.0 will simply ignore this 

file. The text file can also be edited or 

created in Notepad – note that there 

are no graphics allowed. It is stored 

with the .cms, .cms, ,cmp files as .txt.  

 

The Edit Source Grid Size button 

which was formerly only available in 

this view is now moved to the Edit 

menu and there is also a button on 

the Control Panel, next to the report 

of Source Grid Size. Please see Edit 

Menu for further information.  
 

1  Print    
Summaries of grid or composite file 

details can be printed using the print 

button . This can be either to a 

real printer or PDFCreator (or similar) 

to obtain a PDF document. 

Optionally, history can be printed out 

at the same time.  

 

 

                                                        Grid File Details 

                                                 Composite File Details 



8  File Menu 
 
8-1  Overview 
 
The File menu provides access to opening and saving data, creation of MasterGrids 

and composites, download and import of data supported by use of Input Templates, 

export of data and printing of the current view. Please note that Keyboard Input 

(present in Geoplot 3.0) has been removed and instead we suggest that if you wish 

to enter data manually you enter these into a spreadsheet and then import that 

data into Geoplot 4.0. 

 
8-2  Details 
 

1  Open Grid and Open Composite    

Separate ‘Open Grid’ and ‘Open Composite’ menu items are located on the File 

menu, including keyboard short cuts Ctrl+Shift+O and Ctrl+O respectively, that allow 

Open to immediately show contents of either the last grid or composite directory 

used, making for faster file selection. The Open button on the top General Toolbar 

will default to the last file type opened but can be changed in the bottom RH corner. 

 

Files recently opened are recorded on the MRU list at the end of the File menu. This 

provides a quick way or loading recent data. 

 

Note that if a Master Grid is not located when you load new composite data then a message to this effect appears in red on the 

status bar and it means original grid file names cannot be displayed on the graphics if desired. 

 

2  Maximum File Size 

Maximum file size is about 200 Mb on a Windows 7 64 bit with 4 Gb memory. Feedback on file size limitations welcome on PC’s 

with different memory sizes or operating systems. The limit will be found by repeated Interpolation – once the limit is reached 

you will see an error message: “Insufficient memory for expansion”. Any feedback from your experience on this point would be 

welcome. 

 
3  Reload Composite    

‘Reload Composite’ discards any unsaved edit, process, tools or macro functions applied and restores the previous composite 

loaded to its unchanged state. A warning is given if there are any unsaved changes to the data before doing so. Unsaved changes 

are indicated by ‘+ + +’ appended after the file name at the top of Geoplot. A ‘Reload Composite’ button is also provided on the 

General Toolbar.  

 

4  Save and Save As    

Use Save to immediately save any changes, use Save As to generate a warning that a data file is about to be over-written. This 

gives you a chance to change the file name. The button on the General Toolbar is ‘Save As’ only. 

 

5  MasterGrid    

A MasterGrid is a template that specifies how individual grids fit relative to one another – the grids are still separate files. The 

individual grid files can be combined into one file called a composite for further data manipulation. Grid names may be added to 

the MasterGrid by typing in (Manual Entry) or by Drag and Drop from a list-box. Use the ‘Browse’ button to select files for the 

list-box. A check box determines whether grid names are removed from the list as they are dragged to the MasterGrid. You must 

save the MasterGrid before creating a composite. Click on ‘Create Composite’ to create the composite file. A checkbox 

determines whether the notes from Grid 1 are added to the composite notes when it is created. After you have saved a 

MasterGrid and created a composite, then if you click on Close rather than Cancel, a new plot will be created automatically 

without having to open the file. Any composite created can be read by Geoplot 3.0 and 4.0.  

 

If you wish you can click on 'Export' to create a spreadsheet text file, with MasterGrid names separated by either tabs, commas 

or spaces. 

 

 



 
 

6  Print    

Please see individual View sections on Graphics, History and File Details for more information on printing whilst in these views. 

You cannot print the Data View. 

 

 
8-3  Input Templates – Download & Import 
 

1  Input Template    

 

When downloading or importing data, as described 

below, you use an Input Template to enter various 

parameters relevant to each task – by default this will 

be one called 0DEFAULT. To save having to re-enter the 

same details every time, you can define an Input 

Template with the parameters you want and save it for 

re-use later on. Whenever you come to download or 

import in future, the names of these templates will 

appear in a list along with the default template. A 

template may be later opened   and edited. 

 

For download you will be only offered a list of Grid Input 

Templates whereas for import you are able to choose 

between a Grid or a Composite Input Template. If you 

decide not to define a template for download or import, 

you will be able to choose 0DEFAULT.GIP for grids and 

0DEFAULT.CIP for composites to progress further.  

 

For download you must use a Grid Input Template, and 

all the data sets should be gridded and of the same size 

and sampling intervals. Data is later joined together as a 

composite using MasterGrid for processing. For import 

it is usual to choose a Composite Input Template since 

this will allow you to start applying processing 

straightaway after importing. 

 

The Help button on the form provides more details of template types and their uses. Import, below, discusses use of various 

templates. 



8-4  Download     
 

To download data, click on the Download button on the top general toolbar or select it from the File menu. This will show an 

initial Input Template selection form which will show the default template 0DEFAULT.GIP and a list of any other templates that 

may have been defined. Select the template you want and then click on the Next button - use the default template if none exist. 

 

If you selected 0DEFAULT then you will see a Survey Type and Instrument selection form. Select a survey type and then 

instrument from the list on the right-hand side. Click Next to show the appropriate default Input Template form – see example 

below. Template details include Mapping, Instrumentation, Instrument Setup and Notes and the actual details shown will 

depend on the instrument selected. If you selected a pre-defined template then this will be shown immediately with entries 

already made, though these can be changed to suit. 
 

  

 

 

      Typical grid name form 



 

The next steps, in summary, are (a) ensure the template settings match the survey details then click Next, (b) in the following 

form enter the grid names, check the COMM port is correct and click on the ‘Make Ready for Download’, then (c) when the 

message ‘Waiting for data … press ‘Dump’ on the instrument’ appears follow this instruction. Data will then be downloaded, and 

a progress bar will update. Note that on the Grid Names form there is a Help button giving advice on USB-RS232 adapters. 

 

When you select the Download process, the Help buttons on the ‘Input Template’ form and ‘Survey Type + Instrument’ forms 

will display the most recent PDF Help file for the download procedure. 

 

In addition, full details of the download procedure are given at the end of the Manual Summary in section 15 ‘Download 

Instructions’ – this includes COM port preparation. A short example of an MSP25 download sequence is also given later. The PDF 

Manual button on the General Toolbar (see later) will display a form that will allow you to view a pdf file called “Download 

Instructions for a Single Twin” which is an RM85 example. Please refer to individual instrument manuals for advice on Input 

Template settings. For example, more complete instructions can be found in Chapter 7 of the RM85 manual, ‘Data Handling’ 

which also gives advice on the template settings for different probe configurations.  

 

Downloaded grid files will be readable also in Geoplot 3.0. If you keep the file names <= 8 characters, then they will be directly 

readable by Geoplot 3.0 but if longer they appear in truncated form when displayed in Geoplot 3.0.  

 

Download now provides support for the RM85 / FAB1 / FGM650 handheld combination and also when an RM85 / FAB1 / 

FGM650 combination is used with an MSP25 system. Download of GPS data is not supported and will be introduced in a later 

version. Note that for the FM256 data format is Fast ASC, ASC and ASC+SPCS only, NOT the FM256 default of Hex D – please 

change the FM256 instrument Data Format setting accordingly. When the memory battery is changed, it will revert to Hex D. 

 
 



8-5  Import   
 
Geoplot is able to import a variety of data types: gridded data, non-

uniform data (NOT GPS referenced), GPS referenced data and LiDAR 

data. This may be from a range of Instruments including: Geoscan 

Instruments, Bartington gradiometers, Frobisher instruments, 

Foerster Ferex multi-sensor arrays, SENSYS MXPDA multi-sensor 

arrays, Geometrics G-864, Scintrex magnetometer. 

 

To import data, click on the Import button on the top general 

toolbar or select it from the File menu. This will show an Import 

Data form where you can choose to import in either Grid or 

Composite form via radio buttons at the bottom of the form. When 

you select either of these, the Input Template box will show a list of 

templates including the default ones of 0DEFAULT.GIP for grids and 

0DEFAULT.CIP for composites. Please refer to Help on Input 

Templates for further information if you are unfamiliar with this 

term. 

 

Select the template you want and then click on the Next button - 

use the default template if none exist. If you selected 0DEFAULT 

then you will see a Survey Type and Instrument selection form. 

Select a survey type and then instrument from the list on the right-

hand side. Click Next to show the appropriate default Input 

Template form. 

 

Normally you will use a Grid Input Template if all the data sets are 

gridded (see below) and of the same size and sampling intervals, 

and data is later going to be joined together as a composite using 

MasterGrid. You may wish to use a Composite Input Template if 

there is only one data set (typically large) and you wish to start 

applying processing straightaway after importing. 

 

When you Import in grid format, this will use the same system of 

templates used for downloading data allowing you to enter 

Mapping, Instrumentation and Instrument Setup. When you import 

in composite format then the template form shows a cut-down set 

of information which always includes at least Mapping and a 

shortened version of Instrumentation.  

 

There are three styles of composite template as shown below: 

Gridded, Non-Uniform and LiDAR. 

 

The Gridded Composite Input Template is used for data that 

matches Geoplot 4.0 data sampling values e.g. 2m, 1m, 0.5m, 

0.25m, 0.125m, 0.0625m etc. (multiples of 2) and which is collected 

on a regular grid – this is typically used in Geoscan and other 

instruments.  

 

You must ensure the Source Grid dimensions can be divided evenly 

into the composite lengths and widths entered. In cases where this is not possible, the Source Grid dimensions can be set to 1m 

x 1m to allow import to take place, but with some restrictions on grid dependent processing functions and the area they act 

upon. It is possible to subsequently edit the source grid size, using the Edit menu or the button in the Data Information panel on 

the right.  

 

Therefore, with some geometries, for example if one dimension (usually horizontal) is exactly divisible by 4, 5, 10, 15 etc, and 

can be set to such a value, this may enable some sensible grid dependent large area processing to be done. Or, even if not 

exactly divisible, it might be useful for some localised Destagger or ZMT processing of a small area, for example. 

 

If you select a User Defined Grid Input Template for import then only the Mapping part will have any entries. The 

Instrumentation details can be entered as you wish for record purposes. 

 

 



 

 

   

     Grid Input Template (left), Gridded Composite Input Template (right) 

 

 

 

 

 

 

 

 

    User Defined Grid Input Template (right) 

 

 

 

 

 

 

The Non-Uniform Composite Input Template is used for data 

that does not match Geoplot 4.0 data sampling values e.g. 

sampling interval of 10cm or variable line lengths. The Non-

Uniform setting is also used for import of GPS referenced data. It 

is selected by changing the Data Sampling drop-down box from 

Gridded to Non-Uniform. 

 

If this is selected the entries for length, width, sample interval 

and traverse interval are no longer displayed in both grid and 

composite templates.  

 

Imported Non-Uniform gridded data cannot be joined together 

using MasterGrid – normally such data will be imported using a 

composite template.  
 

     Non-Uniform Composite Input Template (right) 

 

 

The LiDAR Composite Input Template is used for importing 

gridded DSM or DTM OS style LiDAR data, 500m or 1000m in size, 

with sampling of 0.25m, 0.5m 1m or 2m.  

 
     LiDAR Composite Input Template 

 

 

 

 

 

 

 



After entering the import details on an Input Template click on the Next button to display the import form. Once you click the 

Next button on the template form you will be presented with the appropriate Import. Four types of import are discussed below:  

Gridded Data, Non-Uniform Data (NOT GPS referenced), Non-Uniform Data (GPS referenced) and LiDAR data. 

 

 

8-6   Import of Gridded Data 
 
Import of a batch of gridded data into Geoplot 4.0 can be made from Z and XYZ files 

(comma, tab or space separated), Spreadsheet (comma and tab separated) and Excel 

(.xls and .xlsx). Note that Excel import requires Excel to be installed on the PC.  

 

A typical grid import form is shown below for importing Bartington Grad-601 data. 

The layout may change slightly, depending on the instrument chosen. 

 

Select the appropriate file format using the Import File Format drop-down box and 

ensure any required details that appear in the Import Parameters group box are 

correct – the defaults are normally appropriate. The default import dummy value in 

the group box can be specified in Environment Options, Import Tab, for routine 

import operations for all the import types.  

 

 

 
 

Next use the ‘Browse’ button below Import File Names to select the files you wish to import - files may be imported singly or in a 

batch. Note that you can set a ‘Browse Extension’ filter to display only those file types you are interested in. The contents of a 

file can be inspected and displayed in an information panel on the right by highlighting it and clicking on Inspect File. From this, if 

there are header lines that should be ignored during an import specify these in the ‘Header Lines to Ignore’ text box; this 

number can be set as a default in Options. Compare the ‘File Contents’ reported at the top of the information panel with the 

calculated readings from the Input Template which is found just below the Import Parameters Group box. Taking into account 

the header lines to ignore entry, the two numbers should match. If they do not, then you can use the Back button to amend the 

Input Template mapping details.  

 

Import can cater for import of data collected at grid edges, i.e. starting at 0, 0, rather than the standard Geoplot 1, 1. This 

collection procedure, typical of Ferex, CMD and other EM data, results in, for the example of a 40m grid with sampling of 1m, a 

resultant data width of 41 readings not the normal Geoplot 4.0 width of 40 readings. A radio button lets you specify the 

sampling pattern, ‘Inside 1m Square’ or ‘Edge of 1m Square’. As the radio button selection changes so does the number of 

calculated readings displayed, and this can be checked against the ‘File Contents’ total to ensure Import parameters are correct. 

See also Import of Non-Uniform data, below, which may be more appropriate. 

 

Next define where the imported data is to be saved using the ‘Browse’ button below the ‘Save To Folder’ field. Note that Prefix 

and Suffix fields are provided to modify file names if you wish. 

 

Assuming the calculated and inspection panel numbers compare, highlight one or more files to import and click on OK. Imported 

files will be saved in the Save To folder.  



 

Use of predefined templates, Options and suitable defaults make routine data imports from instruments such as the Grad-601 

easy to achieve. The example above shows Bartington Grad-601 data about to be imported as a Z file – the Header Lines to 

Ignore (=14) and Import Dummy value (=32702) are set in Import Options for convenience. 

 

Import of Frobisher Instrument Data 

In the case of Frobisher instrument data (Resistance: TAR-3 and Gradiometer: DFG-1), these are catered for when specifying the 

Import Type and Instrument. Only the XYZ comma separated variable files are catered for. The Input Template takes into 

account the fact that these instruments have X and Y swopped relative to the directions normally expected in Geoplot 4, so, 

providing you enter the Mapping details, as specified on the form, then this is taken account of and the data is automatically 

rotated 90 degrees internally so that the first traverse is horizontal, in keeping with the Geoplot approach. Grids can 

subsequently be assembled into composites using a mesh definition with this orientation. The Input Templates also take into 

account the different dummy values used in the resistance (2047.5) and gradiometer (999.9999) instrument. You must ensure 

you enter Mapping details according to the instructions given on the form, in red – see below. 

 

 
 

 

 



 

8-7   Import of Non-Uniform Data (NOT GPS reference d) 
 
Import of a batch of non-uniform data into Geoplot 4.0 can be made from XYZ files (comma, tab or space separated), 3 columns 

of data. The procedure for importing is very similar to that for gridded data with the following differences: (a) there is no 

calculation made of the file contents, (b) there is no grid edge definition, (c) there is an option to rotate the imported data 

through +90 degrees and (d) an Allocation Matrix size, typical setting 8x8 samples/m, can be set and controls how finely or 

coarsely the data will be re-sampled into Geoplot format - – see form below.  

 

Non-uniform import allows data to be imported from non-Geoscan instruments such as Foerster Ferex multi-sensor arrays 

which have different sampling intervals to those used in Geoscan instruments. 

 

A typical Import Form is shown below for importing Foerster Ferex data shown above where the data sampling is every 10cm 

that does not match Geoplot sampling. Use the ‘Browse’ button below ‘Import File Names’ to select the files you wish to import 

- files may be imported singly or in a batch. Note that you can set a ‘Browse Extension’ filter to display only those file types you 

are interested in. The contents of a file can be inspected and displayed in an information panel on the right by highlighting it and 

clicking on Inspect File. From this, if there are header lines that should be ignored during an import specify these in the ‘Header 

Lines to Ignore’ text box; this number can be set as a default in Options. 

 

Here there are 8 grids to import, and the first 15 lines of header information are to be ignored. Allocation Matrix can be set to 

1x1, 2x2, 4x4, 8x8 or 16x16, with 8x8 being a typical setting. It is better to set the sampling too high and interpolate down, 

rather than sample too coarsely. 

 

 

As in the example above for gridded data, set the Save To Folder and any prefixes or suffixes and highlight all the grids to be 

imported. Example Ferex data is provided in the directory Import_Data\JF_Foerster_Ferex in the form of 8 grids which can then 

be combined into the composite shown right.  

 

A MasterGrid is provided in Mesh\JF_Foerster_Ferex that indicates how the grids would fit together once imported. Note that 

grids 1, 2, 5, and 7 require rotating through 180 degrees after import before assembling in the MasterGrid – they have been 

given the suffix ‘_Rot’ to signify rotation. 

 

After data has been imported and assembled into a composite, this will consist of parallel lines of true data separated by one or 

more lines of dummy data. Depending on the traverse interval, you may need to increase magnification to seem them initially – 

see the image below. In this case the data has also been rotated through 90 degrees to orientate traverses horizontally.  

 

Then use the Interpolate-Shrink Linear process function one or more times in the Y direction (not the traverse direction) to 

remove the dummy readings and build up the required image. You can use the reported traverse interval in the RH control panel 

as a guide as to how far you should shrink the data compared to the original data collection resolution. 

 

The result is shown below and has a resulting sample interval of 0.125m (compared to 10cm initially), and a traverse interval of 

0.5m. The data requires application of Zero M Traverse to remove the banding. 

 



 
 
 

 
 

 

 

 
 
 
 



8-8   Import of GPS Referenced Data as a Composite 
 
The Non-Uniform import data format can also be used to import GPS referenced data and then process it. Excel will typically be 

used to prepare a file that it is supplied as an XYZ comma separated file with either UTM or northing and easting coordinates 

plus data. GPS data should be imported as a composite since Interpolate-Shrink Linear will need to be used. This means you 

should use or create a composite input template first. 

 

Note that grid specific (e.g. ZMT) or line specific (e.g. Destagger) process functions will not yet work directly with GPS referenced 

data. A work around for GPS referenced data that has also been collected on a gridded basis can have these functions applied 

first, as gridded data, then exported and re-imported as GPS referenced data. Instrumentation which is able to offer the data 

with sensor offsets already removed, e.g. SENSYS MXPDA helps remove the need for ZMT etc.  

 

The procedure for importing is very similar to that for gridded data with the following differences: (a) there is no calculation 

made of the file contents, (b) there is no grid edge definition, (c) there is an option to rotate the imported data through +90 

degrees and (d) an Allocation Matrix size, typical setting 8x8 samples/m, can be set and controls how finely or coarsely the data 

will be re-sampled into Geoplot format. A typical import form for importing SENSYS MXPDA data is shown below. Note that the 

maximum file size that can be imported is about 200 Mb so you may need to reduce the file size using MXPDA. The file shown 

below is 105 Mb in size. 

 

 
 

 



Use the ‘Browse’ button below ‘Import File Names’ to select the files you wish to import - files may be imported singly or in a 

batch. Note that you can set a ‘Browse Extension’ filter to display only those file types you are interested in. The contents of a 

file can be inspected and displayed in an information panel on the right by highlighting it and clicking on Inspect File. If the file is 

too big you will get a memory error message and if so you should restart Geoplot and try with a smaller import file size.. The 

Allocation Matrix can be set to 1x1, 2x2, 4x4, 8x8 or 16x16, with 8x8 being a typical setting. It is better to set the sampling too 

high and interpolate down, rather than sample too coarsely. 

 

Also define where the imported data is to be saved using the ‘Browse’ button below the ‘Save To Folder’ field. Note that Prefix 

and Suffix fields are provided to modify file names if you wish. 

 

After data has been imported the composite will consist of a cloud of points positioned on an allocation matrix of typically 8x8 

points/m (resolution of 0.125m) – you may need to increase magnification to seem them initially. 

 

Next use the Interpolate-Shrink Linear process function multiple times to remove the dummy readings in the point cloud and 

build up the required image. You can use the reported sample and traverse interval in the RH control panel as a guide as to how 

far you should shrink the data compared to the original data collection resolution – you should be aiming for the same sampling 

in X and Y as used for the original data collection. If you import GPS data in a routine situation then a macro could be defined to 

automate this process. Once you have shrunk the data as far as is appropriate you can use the GPS Gap Fill tool to fill in dummy 

areas that may have arisen due to poor-quality GPS positioning. Typically, the data will then be low pass filtered and 

interpolated as for standard gridded data. Please see Help for GPS Gap Fill to see the above data set processed. 

 

Before shrinking the data, you can use Search and Replace to temporarily change all the readings to a single-value, typically 1, 

and then, with appropriate plotting parameters minimum=0, maximum=1, Absolute, and after clicking the ‘T’ button (below the 

palette on the right hand side) to make dummy readings transparent, you can see an image of the GPS tracks and points. For 

large data sets there may not be enough magnification to see the full detail though, as with the data set above. An example 

from a smaller and simpler data is shown below. 

 

 
 

 
 
 
 
 
 
 



8-9   Import of LiDAR as a Composite 
 
Import includes import of DSM and DTM LiDAR data 

from sources such as the Environment Agency 

Geomatics Survey Open Data.  

 

The files can be either 500m or 1000m in size with 

sample intervals of 0.25, 0.5, 1, 2m. An example file 

for import can be found in the 

Import_Data\LiDAR_DTM_2m directory. It has 

dimensions of 500m x 500m and a sample interval of 

2m. Select LiDAR from the instrument choice to bring 

up the Input Template form designed for LiDAR data 

– see right where it is configured for the sample data: 

1000m x 1000m and 2m sample and traverse interval. 

Clicking next will display the Import form. 

 

Geoplot 4.0 automatically takes into account the 

header information and import dummy value for 

LiDAR data though you should compare the file 

contents above the inspection box with the 

calculated number of lines and use the Back button if required to change the Input template parameters. When you first open 

up the data the default x1 graphics plot size of x1 will be too large so you should reduce the size to typically x1/4 or less, 

depending on your screen size. Application of HPF (10 x 10) should reveal much more detail in the image than is first apparent. 

Shade - Relief plots can also reveal fine detail. 

 

 

  
 

Imported example LiDAR data   Imported example LiDAR data after HPF 10x10 

 
 
8-10  Export     

 

At present files can only be exported one at a time. Export provides formats: Z, XYZ 

(comma, tab, and space), Spreadsheet (comma, tab), Geosoft, Surfer (ASCII) and 

Grass for GIS. A setting for export of XYZ-CommaSV data allows insertion of a space 

before numbers to allow ArcGIS to import the data correctly – see right. The 

preferred setting can be set in Export Options. 

 

Exporting in Surfer (ASCII) format provides a rapid and convenient way of getting 

data into Surfer as a Surfer grid file, minimising preparation required. 

 

 
 



9  Edit Menu 
 

9-1  Overview 
 
The Edit menu comprises: Undo, ‘North Direction’, ‘Units’, ‘Source Grid Size’ and ‘History 

Comment Editor’. Please note that Edit data has been removed from here and is now found in 

the Data View form. 

 

9-2  Details 
 

1  Undo     

‘Undo’ reverses the last Edit, Process, Tools and macro function applied to a grid or composite. It is only single level so if you 

wish to remove the effect of a chain of any of these functions then use ‘Reload Data’ (composites only). An Undo button is 

provided on applicable forms, as well as on the General Toolbar. The key combination Ctrl-Z can also be used. 

 

2  Edit North Direction     

Edit North Direction changes the direction of the north symbol displayed in the right-hand 

panel only, and leaves the data set unchanged. Use this function to modify an incorrect 

setting for 'Dir. 1st Traverse' when downloading data - if the Grid File Details view is being 

displayed then the entry for 'Dir. 1st Traverse' will change accordingly.  
 

3  Edit Units    

Edit Units changes the units displayed in the right hand panel. Use this function to modify an 

incorrect setting for 'Units' when downloading or importing data. There are many predefined 

choices from the drop down list or you may define your own. If the File Details view is being 

displayed then the entry for 'Units' will change accordingly.  
 

 

 

 

4  Edit Source Grid Size    

Edit Source Grid Size can be applied to composites only and allows you to effectively change 

the size of the displayed grid lines overlaying a composite – the number of grids displayed will 

change along with their numbering. Temporarily changing the grid source size can be used to 

isolate and home in on, for example, the top half or quarter of an original grid for Destagger 

or ZMT application where you do not want to apply it to the whole of the grid. Once a process 

function has been applied, edit the source grid size back to its original size again. Each change 

of source grid size will be reported in the History. As well as appearing on the Edit menu, it is 

also accessible via a button on the Control Panel, Data Information, next to the report of 

Source Grid Size. The edit function Source Grid Size was formerly available only in the File 

Details view, F8 but is now moved to the Edit menu. 

 

5  History Comment Editor    

History Comment Editor allows you to add a comment at the end 

of the History report or insert a comment part way through. This 

can be a useful reminder of why specific process steps were taken. 

Make an entry in the 'History Comment Text' box and click 'Add 

Comment' to position it at the end. Click on one of the History 

lines and then 'Insert Comment' to position it just before the 

highlighted line. Any comment created will be enclosed within two 

'======' lines of text. Comments and the '======' lines can be 

removed by highlighting a line and clicking 'Delete History Line' - 

be sure to remove the '======' lines as well as the comment. You 

cannot delete actual lines of history, only comments. 

 
 



10  Tools Menu (including Macros) 
 

10-1  Overview 
 
The first six menu items, ‘Rotate Data’, ‘Flip Data Vertical’, ‘Flip Data Horizontal’, 

‘Invert Traverse Mode’, ‘Shift Data’, ‘Swop Adjacent Traverses’ and ‘Add Alternate 

Traverses’ can all be applied to composites. However, ‘Shift’ and ‘Add Alternative 

Traverses’ cannot be applied to grids and will be greyed out when grid data is 

loaded. All these functions can also be accessed from the vertical or horizontal 

toolbars. 

 

Please note that Create Pseudo-Section has been removed from the Tools menu 

and will now be implemented in the next version of Geoplot.  
 

 

10-2  Details 
 

1  Rotate Data       

'Rotate Data' rotates the underlying data set through 90, 180 or -90 degrees. The 

graphics and north symbol will rotate by the same angle to reflect this. Rotation 

through 90 degrees can be used to effectively apply direction dependent 

functions such as Zero Mean Traverse at right angles to the traverse direction. 

Data can then be rotated back through 90 degrees. ‘Rotate Data’ can also be 

accessed from the vertical toolbar and the two buttons to the right of the north 

symbol on the right-hand panel (Rotate Data 90 degrees clockwise and Rotate 

Data 90 degrees anti-clockwise) and will be quicker to use for +/- 90 degrees rotation. 

 

2  Flip Data Horizontal and Flip Vertical       

These functions create mirror images of the data in the horizontal and vertical directions, useful for situations where grid data 

was accidentally or deliberately collected with the starting traverse direction opposite to that recommended. 

 

3  Invert Traverse Mode    

‘Invert Traverse Mode’ is used to correct for data being incorrectly specified as Zig-Zag or Parallel during download. It changes 

alternate lines of the data set.  

 
4  Shift    

‘Shift’ can be used to move the data set in either the X or Y directions, by a specified number of readings, plus or minus in value. 

The blank strip, left as a result of a shift, will be filled with dummy readings. Shift can be used to re-align different data sets, such 

as resistance and gradiometer data collected on an MSP25 cart, since the gradiometer data will be displaced from centre by 

0.75m; with a sample interval of 0.25, a correction of +/-3 readings can be applied, depending on whether the gradiometer is at 

the leading or trailing edge. The Y shift can also be used to compensate for the slight shift that happens when you Interpolate 

data. This is an interim measure, and we hope to stop Interpolate shifting data in the future. 

 

5  Swop Adjacent Traverses    

‘Swop Adjacent Traverses’ is a legacy function used to correct for incorrect wiring by the users of the PA5 / PA20. 

 

6  Add (Alternate Traverses)    

‘Add (Alternate Traverses)’ can be used with gradiometer data to add (or subtract) a number from alternate traverses or pairs of 

alternate traverses. This acts as an alternative to using Zero Mean Traverse and will alter the data much less, thus reducing the 

chance of losing features running parallel with the traverse direction. It can be used with single or dual gradiometers. In the 

latter case, two independent Add values can be entered, one for each of the pair of traverses. 

 

7  Merge Composites    

‘Merge Composites’ allows two composites to be merged into one, useful for dual gradiometer data and multiple and parallel 

resistance data sets. Set the survey type you want to merge: ‘Dual Gradiometer – FM256’, ‘Multiple Resistance’ or ‘Dual 

Gradiometer – Grad601’. The Merge Parameters and graphic below will change according to the Survey Type. In addition, if you 

change the Rotation Angle, the graphic will also change as a visual reminder of the setting. Use Browse to display a list of file 

names, select a pair then click on Merge. You will then be prompted for the name to save the merged data set with. Note that 

data is extracted in the order defined by the 1st and 2nd filename suffixes specified. Therefore, you may need to add or edit and 

save any suffixes that require their suffix to be created or changed, for example if the pair have the same ending.  



After merging, if you click on Close rather than Cancel, a new plot will be created automatically without having to open the file. 

Tools and Edit Options allows you to preset Survey Type, Rotation Angle and the 1st and 2nd Suffix. 

 
 
 

8  Create Blank Composite    

‘Create Blank Composite’ allows one to define a blank composite canvas on which to paste data from grids or composites using 

the Cut and Combine process function. 

 

9  Convert Grid to Composite    

‘Convert Grid to Composite’ tool is useful for bypassing the MasterGrid approach to creating a composite if only a single grid has 

been downloaded. It is useful also when you wish to apply some processing functions e.g. FFT to a specific grid (and then use 

Convert Composite to grid – see next). It appears in the menu or on the horizontal toolbar. 

 

10  Convert Composite to Grid    

‘Convert Composite to Grid’ complements ‘Convert Grid to Composite’, allowing you to apply some processing functions and 

then change it back to a grid, perhaps for inclusion in a MasterGrid. It appears in the menu or on the horizontal toolbar. 

 

11  Stripe Defect Removal in Non-Bipolar data    

The ‘Stripe Defect Removal in Non-Bipolar data’ tool (see also the macro section below) is designed to remove stripe effects in 

resistance data.  

 

12  Create Survey Perimeter Outline    

The ‘Create Survey Perimeter Outline’ tool generates an outline of the survey area 

(transparent by default) which is useful for generating interpretations and reports. 

Any dummy regions within the survey will also have an outline drawn round them. 

Note that during the generation of the outline Geoplot 4.0 may change the 

magnification to ensure the outline is visible. If it does this ensure that you save the 

image at this magnification. The Save Image form will be launched automatically 

providing the checkbox for this is ticked. The example composite data provided in the 

Castle directory can be used to try this tool out – see images below.  

 

There is a reminder on the ‘Create Survey Perimeter Outline’ form to say that the 

data must use 2047.5 as a dummy reading for correct operation. 

 



 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
13  GPS Gap Fill    

A ‘GPS Gap Fill’ tool can be used for completing imported non-uniform GPS referenced 

data, filling in any dummy areas left after the interpolation process – see Import of GPS 

Referenced Data. Selecting the tool displays the GPS Gap Fill form. Two GPS Gap Fill 

methods are available: (a) the original method provided in Build 1322 and earlier, and 

(b) an improved version provided in builds later than 1322. The improved method 

preserves the original data and merges this with a new form of generated gap fill data. 

The original method could lead to excessive blurring of data, especially when required to 

be used more than once. 

 

14  Calculator    

The Calculator tool provides a convenient way of making simple calculations during 

processing and capitalises on special one-click copy and paste operations possible in 

various parts of Geoplot. It can save several keyboard clicks and mouse highlight 

movements, compared to using the Windows calculator.  

 

The calculator is in the bottom right-hand corner and can be hidden or shown by using 

the Tools Menu or clicking on the Calculator icon on the General Toolbar. Environment 

Options controls whether it is shown at start-up or not.  

 

You can enter values for variables A and B and then perform Addition, Subtraction, 

Multiply, Divide, raise A to the power of B or calculate the square root of A. Use the 

result in various process functions such as Add, Divide or Multiply, either entering the 

result manually in these functions, by single clicking on the field or by copy and pasting 

from the result text box into the function form. 

 

Values for A and B can be entered manually, or you can instead use a drop-down list of 

existing map statistics for speedy parameter entry, including current value of +/- Mean, 

+/- Dummy, +/- SD levels. See the example opposite. Remember that if you use the 

drop-down list, the value set in A or B will change dynamically as processing 

proceeds. 

 

If you have used the Statistics function to display the statistics of a block of data, then 

you can single click on any statistics value to place it on the Windows clipboard (the 

field will briefly turn green to indicate it has been placed on the clipboard) – see image 

at the end of the Example section. Then on the Calculator form simply single click on 

either A or B to enter the value (or paste conventionally). Similarly, you can click on any 

value in the Data Information panel, which will temporarily turn green to place it on 

the clipboard – again see image at the end of the Example section. You can also copy 

and paste a value from the Process History or from the Scratchpad. 

 



Once you have values set for A and B then click on the appropriate mathematical 

function and the result will be displayed in the text box above. You can change the sign 

of this result if appropriate using the +/- button. The result value can be copied and 

pasted normally, or you can single click once on the field to copy it direct to the 

Windows clipboard – when you do this it will briefly turn green. The value can then be 

used elsewhere. 

 

Add, Divide and Multiply have special provision to allow you to single click paste the result into their Value fields, or you can 

right click and paste as normal. If you find single click paste into Add, Divide and Multiply is not what you want, then you can 

click on the Add, Divide or Multiply forms Option button to take you to the Process Options form where you can disable this 

operation. 

 

You can use the Clear A and Clear B buttons to clear those fields, along with the result. 

 

The scratchpad can be very useful for building up a sequence of values to copy and paste from when doing a batch process. 

Example 

An example of Calculator use is normalisation of all the grids in a composite using SD as a measure. The SD of the grids you want 

to normalise would be entered in A whilst the SD of the reference grid to normalise to would be entered in B. Note that in this 

case, you should enter a fixed value here - if you have entered the B value using +1.0SD from the combo box then the value will 

change dynamically as the data is processed. You would select each grid in turn using Process Block with snap to grid set to on, 

then use the Statistics tool to measure the SD of a grid, single click on the 1 SD field in the Statistics report to copy the value to 

clipboard, then single click to paste the value into the A field. Click on the A/B button to evaluate and then single click on the 

result text box to place it on the Windows clipboard. Leave the Calculator form and then select the Divide process function. 

Either single click on the Value field to insert the clipboard value, or right click on Value field and paste as normal and then click 

OK to normalise the grid (the same process block will be used).  

 

Next move the process block to the next grid and repeat, just entering a new value in the A field each time. The sequence above 

saves keyboard clicks compared to using the Windows calculator. 

 

You can see below examples of single clicking on a field to place a value on the Windows clip board - Statistics form on the right 

and the Data Information panel on the left. 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 



10-3  Macros 
 
1  Macros 

Macros allow users to define and save a sequence of data 

processing steps with specified parameters - the macro can 

then be run with a couple of mouse clicks to greatly speed up 

data analysis. A Macro Editor is provided to let you define 

your own macros. Some Tool functions, such as Stripe Defect 

Removal in Non-Bipolar Data, Create Survey Outline and GPS 

Gap Fill, are based on a macro sequence. 

 

2  Run Macro    

Once a macro is created in the Editor and saved with a user 

defined name, the macro can be accessed from Run Macro 

form which shows a list of existing macros. Select a macro and 

click OK or double click a macro to run it immediately. 

 

When a macro is run its name is shown in the History list. Undo removes all functions associated with the macro from the list in 

one go. Options allows you to include just the macro name in History or the full sequence of instructions. Use the Macro Editor, 

described later, to define your own macros. 

 
3  Macro Editor     

The macro editor allows users to define and save a sequence of data processing steps with specified parameters; this macro can 

then be run using Run Macro (see above) to greatly speed up data analysis. Comments can be added to the macro and the 

definition can include temporary files for saving intermediate results. If required a macro can also allow you to enter up to 8 

initial filenames and you can use fixed or variable statistics for intermediate calculations. Several macros are already provided 

including ones for (a) ‘Stripe Defect Removal in Non-Bipolar data’ i.e. equivalent of Zero Mean Traverse but applied to resistance 

data, (b) generate a range of contour plots which can be overlaid on other data sets, and (c) another to provide a broad HPF for 

data sets with higher sampling intervals. During development, macros can be created and evaluated using the Test Macro and 

Undo Macro buttons. 

 

To create a macro, highlight a function from the Function List and as soon as you do this the appropriate function will appear in 

the Selection box. Make your entries in the function form, just as you would when using a normal process function. Usually, you 

will click Add Selection to add it to the list that will appear in the Macro Script list box on the right-hand side. If, during creation 

of a macro, or editing of a macro, you want to insert a function then highlight the point where you want to insert it just before, 

then click on Insert Selection. If you add or insert an incorrect function, then highlight it and click on Delete Line to remove it. 

 
 

 
 

 

 



4  Add or Insert a Macro Comment 

If you want to add or insert a comment then you can 

use the Add Comment and Insert Comment buttons in 

the same way, and optionally also include 

‘==========’ demarcation lines for clarity.  

 

 

 

 

5  Work with Temporary Maps of Intermediate Results 

The top three quarters of the Function List replicate the normal process functions to be found on the Process menu or toolbars. 

The next block of functions, Open Macro Map, Save Macro Map, Sum Macro Maps, Multiply Macro Maps and Define Macro 

Maps allow you to define temporary files for saving intermediate results as you work within a macro.  

 

Often you may wish to save the starting data set for later use during a macro so you can use the Save Macro Map function to 

save it as one of 8 maps for later recall using Open Macro Map – see illustration to the right. 

 

 

6  Addition and Multiplication of Macro Maps 

If you want to add (or sum) an intermediate macro 

map to the one currently being worked with during a 

macro, then use the Sum Macro Maps function to 

define which map should be added. You can do the 

same if you wish to multiply maps together using the 

Multiply Macro Maps function. 

 

 

 

 

7  Define Multiple Source Data Sets 

The function Define Macro Maps allows you to define 

a group of initial source data sets to work with. This 

should always be the first macro command, if used. 

Note that the data sets must all have the same size 

and sampling. When you run the macro, a form will 

appear (see below) that allows you to browse to the 

file definitions of MacroMap1, MacroMap2 etc. 

 

 

 

 



8  Fixed and Variable Statistics 

Macros can use map statistics such as mean and standard deviation and 

normally you will be using the current values, whatever they may be. 

However, in some situations you may need to define whether the statistics 

are those of the original data set or whether fresh calculations need to be 

made. The bottom two items in the Function List, Use Fixed Statistics and 

Use Variable Statistics, allow you to do this.  

 

The ‘Use Fixed Statistics’ function will calculate fresh statistics. Any 

subsequent function using SD or mean will use these fixed values rather than 

the latest statistical values.  

 

The ‘Use Variable Statistics’ function will stop the use of fixed statistics and 

will calculate fresh statistics and any subsequent function using SD or Mean 

will use the latest statistical values rather than fixed values. 

 

Use of variable statistics is normal macro behaviour and there is normally no 

need to insert the Use Variable Statistics function unless the Use Fixed 

Statistics function has been used before. Note that if using the ‘Define Macro 

Maps’ function then the starting statistics for the macro will be based on the 

last map loaded. Insert a ‘Use Variable Statistics’ function if using another 

map first. 

 

        
 
 
9  Example Macros 

Several example macros, of varying complexity, have been provided in the Geoplot 4.0 installation. The most straightforward 

one is ‘Despike MSP25 Data’ which is simply a sequence of repeated Despike steps with varying parameters. You can open this 

macro from within the Macro Editor form to see the steps involved and the number of operations saved by using a macro 

instead of individual process applications. 

 

A more complex example is provided by the 

‘Remove Stripe Defects in Non-Bipolar 

Data’ macro. Open this up in the Editor so 

you can see the steps involved whch 

include Save MacroMao, OpeMacroMap, 

LPF, HPF and Cut and Combine.  

 

Try applying this macro to the sample 

composite data found in Restripes. The 

results are shown below. You can see that 

there has been no need to specify the statistics type here since they are not fundamentally involved. To become familiar with 

creating your own macros you can try recreating this example. As well as being in the macro Run list this particular macro can 

also be found on the Tools menu. 

 



You can also open the Create Survey Perimeter Outline to see 

how this operates. Try it with the example composite ‘1’ in the 

Castle directory. Whilst this is also present on the Tools menu 

(see Tools Menu (including Macros) section), operation has 

been extended there to also change the plot size, hide the 

border, hide grid lines, set appropriate plotting parameters and 

launch Save Image. When developing your own macros then 

you may also find you have to modify the Geoplot environment 

to get the best result.  

 

 

 

 

 

 

 

In the case of the contour macros, the choice of best palette can help 

present the result you require. Try using the Contours macros with the 

example composite AZILC provided in the Gherb directory. Plot the data 

using the ‘Colour 14’ palette and +/- 3nT SD clip parameters then run the 

macro ‘Contours-Positive Threshold = +3    [Best with 0.125m intervals]’. 

After a short while the contour plot shown below should appear. Although 

you should get better data using 0.125m sampling intervals, as advised by 

the macro, 0.25m sampling is still acceptable.  

 

Note that this macro does make use of the Mean statistics but again there 

is no need to specify fixed or variable statistics.  

 

 



11  Process Menu 
 

11-1  Overview 
 
Process functions can be applied to composites, but not grids. The functions can be 

accessed from the Process Menu or toolbars. A detailed guide to process functions can 

be found in Geoplot 3.0 documentation – this can be accessed by clicking on ‘PDF’ on 

the General Toolbar and then selecting ‘Geoplot 3.0 Processing Reference’. Additional 

comments on some process functions and operations are given below. 

 

The latest process history is shown at the bottom of the right-hand control panel; a 

floating, re-sizeable history form is also available when working in the Graphics view. 

Alternatively, a full report is given in the History view. You can change the default 

process form parameters that are displayed in Process Options. 

 

The functionality of some process functions has been extended, e.g. you can quickly 

perform a multiple number of Low Pass Filter operations at 1x1 which is useful for 

smoothing data without losing crispness. Again, the default number of operations can 

be set in Process Options. 

 

When appropriate, many parameters can be entered as a straightforward numerical 

value or you can instead use a drop-down list of existing map statistics for speedy 

parameter entry, including +/- Mean, +/- Dummy, +/- SD levels and +Mean/2, +Mean/5. 

See the Clip form example below, right. You can set a preference for the drop-down 

order (positive or negative first) in Process Options for Clip & Search/Replace. 

 

You can use ‘Undo’ to reverse the effects of the last process function. It is only single 

level so if you wish to remove the effect of a chain of process functions then use 

‘Reload Data’. An Undo button is provided on all process forms, as well as on the 

General Toolbar. The key combination Ctrl-Z can also be used. 

 

 

11-2  Details 
 

1  Cut and Combine    

Cut and Combine now has a checkbox for determining ‘Paste’ action for dummy 

readings. The default action is for any pasted dummy to replace existing data, but this 

can be turned off to preserve any original data value if desired. Cut and Combine also 

has a check box for determining ‘Add’ action for dummy readings. The default action is 

for dummy readings to be ignored when adding data sets. If the checkbox is ticked, 

then added dummy reading will replace data. You can use the mouse to look at 

coordinates of graphics areas whilst the Cut and Combine form is active. 

 

2  Destagger    

The Destagger process function has been extended so that 2-5 lines can shifted at a 

time, useful for multi-sensor magnetic arrays such as Ferex data. Destagger has also 

been extended so it can be applied to individual grids, all grids individually or the whole 

composite. The latter addition can help prevent edge artefacts. 

 

3  Median Filter    

Median filter is now working correctly with no shift in the X and Y directions.  

 

4  Zero M Traverse    

The function of Zero M Traverse has now been extended to work with either Mean or Median as the Zero Measure which is 

subtracted from the traverse data. Both may be used with or without application of Thresholds. Thresholds are very useful for 

working in the presence of very strong features often given by ferrous features) or for preserving weak features running in the 

traverse direction. Least Means Square Fit can also be used with both measures. Application of the Zero M Traverse process can 

be restricted to a few lines at the start and end of a grid. This can be useful in preserving data when data is rotated through 90 

degrees and Zero M Traverse is applied to reduce just grid start/end discontinuities – the start and end settings limit the regions 

over which Zero M Traverse is applied. 

 



5  Statistics Report    

The statistics report form that appears after you select a data block now has an option to save a summary of the statistics to the 

Windows clipboard. This can be pasted into the ScratchPad, Composite Notes or other locations that accept text. When you click 

on this button all the statistics fields will briefly turn green to indicate they have been copied and a summary prepared. An 

example of the report that appears on the clipboard is: 

 
Statistics for file: C:\Geoplot\Comp\Rgrv\2.cmp 

Mean = 70.02078 

1 SD = 30.32029 

2 SD = 60.64058 

3 SD = 90.96087 

Minimum = 55.15 

Maximum = 662.0 

Block = Inclusive Block 

Top Left X Y =  14, 15 

Bottom Right X Y =  27, 42 

 
You can also click on any statistics or block value which will briefly turn green to 

indicate it has been placed on the clipboard for pasting elsewhere.  

 

Note that in addition you can copy a summary of all the Data Information from the RH 

Control Panel, which includes statistics and mapping sizes, using the  button to the 

right of ‘Mean’ to place the information on the clipboard and then to the Scratchpad. 

 

6  Check Effect of a Process Function    

Once a process has been applied the effect of that last process function can be 

displayed by clicking on the triangle symbol (general toolbar) and the display will 

show the difference. In the example below this shows the spikes removed by Despike; 

click the triangle symbol again to restore the processed data. Checking data in this 

way is important for avoiding over-processing of the data. The normal Undo state is 

unaffected. 

 

  
 

 

This approach has been extended further with provision of Undo and Check Process effect buttons on most process function 

forms making it easier and quicker to experiment with different parameters directly on the form. See the example of the 

Despike process form to the right. Remember this is a single level undo. 

 

7  Process Block Selection    

The Process Block selection function is accessed using the P button on the horizontal toolbar. The mouse is used to draw an 

orange rectangle that turns green once the mouse is released.  The rectangle snaps to reading or grid, depending on the check 

box setting on the selection form – the current status is shown in the bottom RH corner (red dot pattern with either a cross or 

green tick below). The ‘P’ has a dark blue background when active. Snapping to grid takes place if you tick the check box and 

click Apply Block on the selection form (snap to grid mode is indicated by the icon to the right of the process block status text in 

the bottom right hand corner). If the initial rectangle is drawn outside the data area it will snap to the nearest edge once Apply 

Block is clicked. To remove the block right click the graphic. If you zoom in or out the block size will now track the size change. 

Note that the block selection button and menu item is disabled whilst Pan is enabled – disabling Pan re-enables block selection. 

 



If you want to resize the rectangle place the mouse over one of the small handles (squares) in the centre of an edge, depress the 

mouse and drag the edge to the new location. As soon as you depress the mouse the Process Block form appears, and the Top-

Left and Bottom-Right text boxes will track changes as the mouse is moved. Alternatively, you can change the text values in the 

form and the green rectangle will resize to match the new text values.  

 

There are three sizes of handles which can be set in Graphics Options. The Normal size is used for routine desktop work. If using 

a touch screen, then the Large or Very Large handles can be used so a stylus or even a finger can be used to resize the rectangle. 

 

  Normal Handle 

 

 Very Large Handle 

 

 

8  Do not Close Forms 

You can specify if process forms should, by default, remain on screen by modifying the first tab of the Process Options page. 

When a form first shows the ‘Do not close form’ will be checked or not checked accordingly. For example, it can often be useful 

to keep Interpolate showing for several operations or keep Despike on screen whilst trying various parameter combinations. It 

can be over-ridden locally on each process form. 

 



12  Options Menu 
 
12-1  Overview 
 
The Options Menu allows you to determine how Geoplot 4.0 is set up and operates. The 

most important of these is the COM port settings for download and you should explore and 

make sure at least this setting is correct. Environment Options let you set default COM ports 

separately for the RM85 and other instruments – this is found in the Download tab. 

Environment options also lets you set dummy values for data, import preferences, export 

preferences and Macro History reporting behaviour. You can now choose to have macros 

show as just a short summary in process history, rather than a full list of process functions 

and parameters used. There are also preferences for MasterGrid, and Sounds. 

 

The Environment, General tab, allows you to configure form colours and which toolbars are displayed. The default behaviour is 

to hide the Horizontal Process and Tools toolbar, shown below since the vertical form of this is usually more convenient. But on 

small displays the horizontal version may be preferable. 

 

 
 

General Toolbar (top) and Horizontal Process and Tools Toolbar (bottom) 

Note that not all General Toolbar buttons will be visible on small screens 

 
 
The Vertical Process and Tools toolbar can be either wide (the default) or narrow. 

 

File path organisation has a very similar structure to that used in Geoplot 3.0 whereby grids, composites, meshes etc. are all sub-

directories of a ‘Geoplot’ directory in the main drive. In Geoplot 4.0 some of the subdirectories have been renamed: for 

example, in Geoplot 4.0 we use ‘Import_Data’, rather than ‘impdata’ used in Geoplot 3.0 and can do so because file names 

longer than 8 characters can now be used, and a more descriptive name can thus be adopted. In fact, it is important that Input 

Template file paths are kept separate for Geoplot 4.0 and Geoplot 3.0 since the file formats are different – hence the different 

file path names and settings from Geoplot 3.0. Grid, Comp, Mesh / MasterGrid file paths are set to be the same as Geoplot 3.0.  

 

Graphics Options allow you to set colour schemes for border, grid lines etc. and determine start up preferences such as display 

of the border, palettes etc. There are options for the Animation Editor and Display Parameters such as overlay opacity. 

 

Process Options allow you to specify which process forms stay on screen after use and set your preferred process form 

parameters. Clip and Search and Replace can have the drop-down combo box information order changed to suit user 

preference. Tools and Edit Options also allow you to specify which forms stay on screen after use and set your preferred Merge 

Composites parameters and set your Create Survey Perimeter Outline parameters. 

 

Throughout Geoplot 4.0 you will find buttons with a red ‘O’ in the centre – these remind you there are Options associated with 

this part of Geoplot 4.0 and if you click the button it takes you directly to the appropriate Options tab. 

 

Note that with each Geoplot build a new set of Options files will generally be installed, along with the executable and other 

support files. Old options files will not be compatible with new builds since the information in them will have a different format. 

Do not try to carry forward old settings by trying to use the old options files since this will cause unpredictable and obscure 

problems. 

 

If Geoplot 4 behaves in an unexpected manner at any stage, then it could be the Options files have become corrupted or are 

not compatible with a later build. To restore correct Options files, exit Geoplot 4.0 and delete the existing Options directory 

in C:\GP400\Options. On restarting Geoplot 4.0 it will offer to create new default options files – these will be saved when you 

next exit Geoplot 4.0. 

 
 

 

 

 

 

 

 



             
 

    
 

                          
 

The five Options Forms  

 
 



13  Help Menu 
 
13-1  Overview 
 

General help is available in the form of a Help Panel, Manual and other PDF Files, 

plus individual Help PDF’s for all Geoplot 4 functions. In addition, floating Help 

forms are available that introduce the basics of processing Resistance, 

Gradiometer and Magnetometer data.  

The Help Panel is accessed by clicking on the  button on the horizontal 

toolbar or by selecting the Help menu and View Help Panel or by pressing F1 and 

this will display the form shown below, left. It will be of use to new users and can 

be resized and positioned in the corner of the screen for reference. The panel has four tabs which cover the essentials: 

Environment, Screen Details, Overview and File Types. It contains the images that follow in the next section. If you want to show 

the panel again, click on the question mark on the horizontal toolbar. You can stop the form appearing again by ticking the ‘Do 

not show…’ checkbox or go to Options, Environment, General. 

PDF Help documents can be accessed by clicking on the button on the horizontal toolbar or by selecting Help menu and 

‘View Manual and other Help PDF Files’ or by pressing F2 and this will display the form shown below. You can select a number of 

these and then click OK to open them in your PDF reader. If desired, tick Select All on the right-hand side to open them all up at 

once. It can be convenient to display these on a second screen for reference if possible.  

 

The document “Geoplot 4.0 Instruction Manual Summary” gives the most up to date information. If you would like detailed help 

on downloading data from our instruments, then select “Download Instructions for Single Twin” as an example or when you 

start the Download process, click on the Help button. The Basic Concepts document summarises the following topics: Data 

Collection, Data Download, Master Grid and Composite Files, Associated Files, Statistics / Histogram Files, Information File, 

Other Geoplot Files and File Extensions and Backups. File extensions are very useful to know when considering what files needs 

backing up or if you are sending copies of these files to someone else. The three Processing Basics documents summarise 

guidance on how you should consider processing resistance, gradiometer and magnetometer data.  

 

If you are new to using Geoplot 4, then the Geoplot 3.0 Manual and Geoplot 3.0 Processing Reference will act as an interim 

solution to understanding in depth many of the process functions.  

As well as the PDF files accessible from the Help menu, there are individual help buttons   on Geoplot forms which you can 

click on to show either another descriptive form or launch a PDF document in your PDF reader. Collections of these Help PDFs, 

grouped as: General Help, Process Help and Tools Help, can also be selected in the PDF Help documents form for viewing. 

 

 
 
 
 
 
 
 
 



Processing Basics Help 
 

The three Processing Basics documents referred to above can also be displayed as floating Help forms for Resistance, 

Gradiometer and Magnetometer data, in the style of the Scratchpad. These forms can be resized to fit within the screen and 

used as a reference when processing. The content has been updated and revised, compared to earlier help information. The 

content can be found in the C:\GP400\Processing_Basics_Help folder as simple text files: HelpResistance, HelpGradiometer and 

HelpMagnetometer. These can be edited by instructors if they wish to provide different information to students. Options, 

General Tab determines if these are displayed each time at program launch. 

 

     
 
13-2 About Geoplot 
 
The About Geoplot Help form summarises which version and build of Geoplot you are using. It also reports on installation file 

paths and version numbers that will be recorded with grids, composites, macros, animation files and input templates. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



14  General Information 
 
14-1  Details 
 

1  Display of Last Data Set at Start-up 

When Geoplot 4.0 starts up it remembers where you were last and will automatically load the last file you used. If you prefer 

this to not happen you can change the behaviour in Options, Environment. Previous file paths used in a variety of situations, 

such as Open, are also remembered. 

 

2  Form Location 

Whenever you use a form and move it away from the centre of the screen, this new position will be remembered and used for 

its location the next time the form is opened. 

 

3  Entry Field Filtering 

Filtering to prevent entering a letter in a numeric field has NOT been applied yet to most fields so take care when entering text 

into fields. 

 

4  Distance and North Scales 

Several distance scales and a variety of North symbols can be found in the installed Image folder which can be used for 

publishing purposes. 
 
5  New Users 

If you are new to Geoplot then you may benefit from following the tutorial in the Geoplot 3.0 manual since this will give you a 

good idea of the structure of Geoplot 4.0. There will be slight differences, but it should give you a basic grasp of the underlying 

concepts of grid, composite and master grid and processing. You will not be able to follow all the tutorial since some features 

such as Publish are not included in Geoplot 4.0. The manual is available from our website but is also installed with Geoplot 4.0, 

accessible by clicking on the ‘View Manual and other Help PDF Files’ button on the general toolbar or go to the Help menu 

and then select ‘View Manual and other Help PDF Files’. The resulting form has the Geoplot 3.0 Manual listed at the bottom. 

Select the checkbox for it and click OK to open it as a PDF. Go to Chapter 3 for the tutorial. 

 
6  Run Simultaneous copies of Geoplot 

Note that you can have several copies of Geoplot 4.0 running at the same time. This can be useful if you want to compare 

different data sets side by side. 

 

7  Maximum File Size 

The maximum file size is about 200 Mb on a Windows 7 64 bit with 4 Gb memory. Feedback on file size limitations welcome on 

PC’s with different memory sizes or operating systems. The limit will be found by repeated Interpolation – once the limit is 

reached you will see an error message: “Insufficient memory for expansion”. Any feedback from your experience on this point 

would be welcome. 

 

8  Windows Screen Scaling (%) 

Some forms require you to set ‘Windows Screen Scaling (%)’ according to the PC Text Size setting to operate correctly. These are 

associated with screen saves: ‘Save Palette and Scale Image’, ‘Desktop Image Save / Print’ and ‘Save Palette and Scale Image’. 

 

 



15  Data Backup 
 

15-1  Overview 
 
The extensions used for Geoplot data files are listed below. When backing up data files, ensure that you backup all files 

associated with grid or composite data, not just data files themselves. Note that Geoplot 4.0 has introduced the additional .txt 

file associated with a composite where survey notes can be recorded. 

 

Grid :  .DAT Data     .GRD Information File      .GRS Statistics and Histogram 

Composite : .CMP Data     .CMD Information File     .CMS Statistics and Histogram     .TXT Notes 

Master Grid :           .PLM File Names and Biases 

Grid Input Template:          .GIP  Grid Input Details 

Composite Input Template:        .CIP  Composite Input Details 

Animation List and Overlays:    .GAN 

 

 

If you have defined any Macros, then backups of these can be made from the location reported in the ‘About Geoplot’ form. 

Backups of Input Templates, Animations, Saved Graphic Images, and Data Exported can be made from the locations defined in 

Options, File Paths. 

 

 



16  Download Instructions 
 
16-1  Download Preparation   
  
Before you can download from an instrument the RS232 or USB communications must first be set up on the PC. This almost 

always involves installing drivers for an RS232-USB adapter or USB drivers for an RM85, unless you are using RS232 and the PC 

has a COM1 port already available. Please install required drivers following the instructions for your RS232-USB adapter or, for 

an RM85, the instructions in section 4-10 of the RM85 manual. 

 

If using RS232, connect the RS232 cable to the RS232-USB adapter when used. If using USB and an RM85 then connect the 

supplied cable to the PC. We recommend you only connect the RM85 to a PC via the USB lead once it is powered up. 

 

Turn on the instrument and select the Comms menu. Select the baud rate you wish to use – the default values in Geoscan 

Instruments and Geoplot Input Templates should match. If you are using and RM85 then set Data Dump Port to either USB or 

RS232. For an RM85 you will normally also have Dump Header = Off, Dump Mode = Linear, Data Format = Fast ASC. In the future 

there will be different settings when downloading GPS data. Note that for the FM256 the data format should be set to either 

Fast ASC, ASC or ASC+SPCS only, NOT the FM256 default of Hex D – please change the FM256 instrument Data Format setting 

accordingly. It will be reset to Hex D if the memory backup battery is changed. 

 

Next, we need to find out what COM port has been 

allocated to the instrument. Navigate to Windows 

Device Manager (Control Panel, System, Device 

Manager) and expand Ports (COM & LPT). Note the 

COM number next to the serial adapter name or 

‘USB Serial Port’ for an RM85. Go to the Geoplot 

Options Menu, Environment, Download tab. For 

instruments other than the RM85 set the ‘General 

Download COM Port’ to the COM number noted 

above. For the RM85 set the ‘RM85 Download COM 

port (USB Virtual COM Port)’ equal to the number 

noted above. In the example below, General 

Instruments will use COM1 and the RM85 COM 6. 

This will be shown by default in a subsequent form 

for entry of grid names, discussed below, and once 

set up in Options, should not need to be changed 

again, so this Download Preparation section will not 

be required for future downloads. If the allocated 

COM number is greater than the range provided by 

Geoplot 4 (1-10) then you will need to reassign the 

RM85 Comm number driver setting in the Device 

Manager view to a number in this range. Once you 

have the options settings correctly defined click 

Apply. 

 

 
16-2  Download Sequence and Input Template    

 

To download data, click on the Download button 

on the top general toolbar or select it from the File 

menu. This will show an initial Input Template 

selection form, right, which will show the default 

template 0DEFAULT.GIP and a list of any other 

templates that may have been defined. Select the 

template you want and then click on the Next 

button - use the default template if none exist.  
 

If you selected 0DEFAULT then you will see a 

Survey Type and Instrument selection form. Select 

a survey type and then instrument from the list on 

the right-hand side. Click Next to show the 

appropriate default Input Template form – see 



example below. Template details include Mapping, Instrumentation, Instrument Setup and Notes and the actual details shown 

will depend on the instrument selected. If you selected a pre-defined template then this will be shown immediately with entries 

already made, though these can be changed to suit. Please refer to individual instrument manuals for advice on Input Template 

settings. For example, more complete instructions can be found in Chapter 7 of the RM85 manual, ‘Data Handling’ which also 

gives advice on the template settings for different probe configurations. The PDF Manual button on the General Toolbar will 

display a form that will allow you to view a pdf file called “Download Instructions for a Single Twin” which is an RM85 example. 

Click ‘Next’ on the Input Template form. 

 

 
 

 

16-3  Download Grid Names 
 

You will now see a form that allows you to enter grid names and below that a combo box that specifies the COM port – this 

should match the Options setting for your instrument or RM85. Note there is a Help button giving advice on USB-RS232 

adapaters. 

 

 



You can either enter names manually one by one in the Grid Names list box, but it is better to click on the Quick Entry button. 

This will display a form that lets you define a Prefix, start and end grid names or numbers and a Suffix. Click OK to populate the 

Grid Names list box. Downloaded grid files will be readable also in Geoplot 3.0. If you keep the file names <= 8 characters, then 

they will be directly readable by Geoplot 3.0 but if longer they appear in truncated form when displayed in Geoplot 3.0. 

 

    
 

Once the grid names have been entered click Next – Geoplot will then scan to see if you already have any grids with the same 

names in a directory that will be composed of a combination of the default grid file path and the Site Name entered in the 

template EG the full path will now be c:\geoplot\grid\sitename (the default grid file paths are set in Options, File Paths and the 

default is c:\geoplot\grid). If Geoplot finds duplicate names, then it will display a message asking you to enter new names - 

Geoplot will not allow you to overwrite raw grid files. If all is well then, a message box pops up telling you what to do next. Once 

you have noted these instructions click OK and you will see a note in a feedback box to the right that the scan of grid names 

PASSED – in fact all subsequent steps are recorded here.  
 

 
 

 

16-4  Make Ready for Download 
 

If you have not already done so then at this point connect an RS232-USB adapter and download cable and power up the 

instrument. In the case of an RM85 and USB cable, power up the instrument and then connect it to the PC via the USB cable. 

Once an adapter or the RM85 has registered with the PC click Make Ready for Download.  

 



 
 

The green button will be replaced by a grey progress bar and above that in red text a reminder of what settings should be made 

in the instrument (the example below is for an RM8) – ensure that the baud rate and Dump Mode match. If you had not 

connected an RS232-USB adapter or powered up your RM85 at this point an error message would appear saying the COM port 

specified in Options does not exist in which case, you would need to rectify this and try clicking on the green button again.  

 

 
 

 

16-5  Dump 
 

Assuming all is well, press dump on the instrument (do NOT press it before this stage). As data is downloaded the progress bar 

updates and you will see a final message reporting download successful.  

 



 
 

 

 
 

Switch off the instrument and click OK. Geoplot will then assemble all the data stream into individual grids.  

 

  
 

When you see the message ‘Reconstruction and save complete’ you can click Cancel to exit the form or Next to try downloading 

again if something went wrong at this point (e.g. mismatch of settings); note that pressing cancel. When you press cancel, you 

will get a warning about losing the grid names entered on the form – this is all you will lose and any data downloaded will have 

been saved, providing you have seen the “Reconstruction and Save Complete” message. You can now return to the main menu 

and open data to look at graphics of the individual grids. In future you may want to define a personal generic template for your 

most used instrument settings, and this will be listed alongside 0DEFAULT. When working on a specific project you could modify 

and save the personal generic template with a project name. 



17  Example Download Sequence - RM85 with MSP25 
 

1 You should first visit Geoplot File Path Options to specify where data will be saved; by default this will be in 

c:\geoplot\grid. Ensure you have already installed RM85 drivers and know the COM port that the RM85 occupies. Go to 

Options, Environment, Download tab and set the RM85 Download COM port to equal this. Whilst you are there, then if 

you use, for example, an RS232 – USB converter for other instrumentation then set the General Download COM port as 

well. In future when you go down the download route below you will be specifying an instrument and these settings 

will be used to setup the appropriate COM port (though you can also change them on the fly during the download 

process if you need to for any reason).  

2 Go to the File menu and select Download or click on the large down green arrow, 3rd from the left on the horizontal 

toolbar. 

3 A form appears that lets you choose a download template. Since you have not defined any specific ones yet select 

0DEFAULT.GIP 

4 The next form lets you specify Survey Type and Instrument. Select Resistance and RM85 + MPX card + MSP25 (Multiple) 

and click Next. 

5 The following form lets you enter Input Template details – you must specify a Site Name and for measuring alpha and 

beta enter 2 in the Readings per station section. You’ll need to change the Mapping details accordingly. It’s useful to 

change the Instrument Setup details as a record of what you did. Add any extra comments in the Notes section such as 

problems with the survey. Click Next. 

6 You will now see a form that allows you to enter grid names and below that a combo box that specifies the COM port – 

this should match the Options setting for your RM85. 

7 You can either enter names manually one by one, but it is better to use the Quick Entry button. This lets you define a 

Prefix, start and end grid names or numbers and a Suffix. More importantly, providing the “Apply auto Multiple Log 

Mode suffix” checkbox is ticked then grid names will be created with ‘a’ and ‘b’ suffixes as well. EG if you enter 1 in 

Start and 2 in End then click OK you will see 1a, 1b, 2a, 2b listed. 

8 Click Next – Geoplot will then scan to see if you already have any grids with the same names in a directory that will be 

composed of a combination of your default file path for grids set in Options (typically c:\geoplot\grid) and the Site 

Name entered in the template EG the full path will now be c:\geoplot\grid\sitename. 

9 If it finds duplicate names, then it will come up with a message asking you to enter new names - Geoplot will not allow 

you to overwrite raw grid files. If all is well a message box pops up telling you what to do next. Once you have noted 

these instructions click OK and you will see a note in a feedback box to the right that the scan of grid names PASSED – in 

fact all subsequent steps are recorded here.  

10 At this point power-up your RM85 and plug into a USB port and once it has registered with the computer click Make 

Ready for Download. The green button will be replaced by a grey progress bar and above that in red text a reminder of 

what settings should be made in the RM85 – ensure especially baud rate and Dump Mode match. If you had not 

powered up your RM85 at this point an error message would appear saying the COM port specified in Options does not 

exist in which case, you need to power up and plug in the RM85 etc. and try clicking on the green button again.  

11 Assuming all is well, press dump on the RM85. As data is downloaded the progress bar updates and you will see a final 

message reporting download successful. Click OK and Geoplot will go ahead and assemble all the data stream into 

individual grids. You can then cancel the form and go to File, Open or use the Open button on the horizontal toolbar to 

look at graphics of the individual grids. 

12 In future, you may want to define a personal generic template for your most used MSP25 settings, and this will be listed 

alongside 0DEFAULT. When working on a project for a few days then you could modify and save the personal generic 

template with a project name. 

 

 

 

 

 

 
 
 
 



18  Installation Files 
 
The following folders (bold text) and files will be installed on your computer. The Program Files folder is used for the application. 

The GP400 folder is used for support files for the application and each folder contains various files not all of which are listed 

below; those text files that are mentioned in installation notes are shown. The Geoplot folder contains example data and is also 

provided for storing user data. All folders contain files apart from Export_Data and Export_Image. 

 

C:\Program Files 
 

Gp400mx.exe 

Microsoft.VisualBasic.PowerPacks.Vs.dll 

 
C:\GP400 folder 

 

Images 

Initialise_&_Exit 

 GeneralFormPosition.txt 

 MRUFiles.txt 

 ProcFormPosition.txt 

 RecentFilePaths.txt 

 Scratchpad 

 Macros 

 Macros_Reserved 

NET_Framework_Web_Installer 

NORTH 

Options 

 EnvironmentOptions.txt 

 FilePathOptions.txt 

 Graphics_GGST_Options.txt 

 ProcessOptions.txt 

 ToolsOptions.txt 

Palette 

PDFHelp 

PDFManual 

Processing_Basics_Help 

 HelpGradiometer.txt 

HelpMagnetometer.txt 

HelpResistance.txt 

Sounds 

USB_Drivers 

 

Build_Version.txt 

Dongle_Insurance.txt 

Licence_Terms_Warrenty.txt 

Readme.txt 

unins000.dat (after installation) 

unins00.exe (after installation) 

 
C:\Geoplot folder 

 

Animation 

Comp 

Export_Data 

Export_Image 

Grid 

Import_Data 

Import_Image 

Input_Template 

Mesh 

 



19  Revision History 
 
Build 1447 Notes 
 
Documentation 

1 Documentation has been extensively revised. 

2 Help files completed throughout for all forms. Viewed as a PDF when clicking on the form Help button. 

3 Collections of these Help PDFs, grouped as: General Help, Process Help and Tools Help, can also be selected in the PDF 

Help documents form for viewing. 

4 Revised the Licence Agreement. 

Installation and Folder / File Organisation 

1 The Geoplot 4.0 installation directories have been changed to ensure compatibility with organisations that do not allow 

an executable to be installed in its own directory on the C drive. The Geoplot executable and its associated .dll is now 

installed in Program Files. In addition, the support directory GP400 has been restructured, along with extensive internal 

code file path changes. The Geoplot folder which contains user data is unchanged. See section 18 above for details. 

2 Before installing this latest version, any earlier version should be uninstalled. This will remove Scratchpad.txt, along 

with HelpGradiometer.txt, HelpMagnetometer.txt and HelpResistance.txt. The latter 3 files may have been modified by 

course tutors for their students and/or Scratchpad.txt may contain notes of work in progress. So, if you wish to 

preserve any of these files for the latest installation, please make copies and then paste them back over the newly 

installed versions. 

3 Do NOT save earlier copies of any of the Options files or Initialise_&_Exit files for use with the new version since the 

information they contain will not be compatible with the latest code. The exception, as noted above, is Scratchpad 

which can be saved. 

Environment and Options 

1 Changes made to Graphics Options: General Tab rearranged and adds ‘Save Palette and Scale’ options – see Graphics 

Menu below for further information.   

2 Changes made to Process Options: Compress Tab, HPF Tab and Wallis Tab have new default settings. 

3 Changes made to Tools Options: added a GPS Gap Fill Tab which includes a ‘Gap Fill Magnification’ setting for the 

improved GPS Gap Fill tool – see Tools Menu below for further information. 

4 File Path Options: file path preferences have been added for the locations of Macros, Palette and Processing Basics Text 

files. For now, we suggest these settings are left as they are since the changes have been made in anticipation of future 

development. If these settings are changed, then you need to make sure you have copied the relevant files to the new 

location.  

5 Extended the length of top banner to accommodate long file paths. 

Graphics View 

1 A green camera button has been added to the Shade Clip parameters area that allows you to save an image of the 

palette and numbered scale, along with optionally: units, north symbol, histogram and histogram colour. A preview of 

the image to be save appears in the top right before you save. Once saved, the preview disappears. Not that Windows 

Screen Scaling needs to be set to match the current Windows setting. 

File Menu 

1 Changed the Import form from Sizeable to Fixed. 

2 Added a Help button to the download form which offers advice on suitable USB-RS232 Adapters for RS2323 download 

cables. 

3 When downloading data, extended the FM256 data format warning message to include Fast ASC, ASC and ASC + SPCS – 

the FM256 setting could be reset to an incompatible Hex D or Hex D+R setting if the FM256 memory battery is changed. 

Graphics Menu 

1 ‘Save Palette and Scale’ has been added to the menu as an alternative to the green camera button described above. 

Processing Menu 

1 Zero M Traverse function has been extended. Application of Zero M Traverse can optionally be restricted to a few lines 

at the start and/or end of a grid. This can be useful in preserving data when data is rotated through 90 degrees and 

Zero M Traverse is applied to reduce just grid start/end discontinuities – the start and end settings limit the regions 

over which Zero M Traverse is applied. 

2 Changed the default values for Compress and Wallis Filter in Options. 

3 Changed default HPF Weighting to Gaussian to match manual text. 

4 Despike can now set a block selection. 

5 Fixed a bug in the FFT function whereby it did not report a correct Frequency Index or Frequency in Trace plots for use 

with Periodic Defect. Shade plots reported a correct value, however. 

6 Fixed a bug in Clip Exclusive Block. 

Tools Menu 



1 The Add Alternate Traverses tool has been extended from working with just single traverses to also work with pairs of 

traverses making it suitable for dual gradiometer data. In the latter case, individual Add values can be entered, one for 

each of the pair of traverses to allow for different characteristics. 

2 The GPS Gap Fill tool has been greatly improved. Two GPS Gap Fill methods are now available on the form: (a) the 

original method provided in Build 1322 and earlier, and (b) an improved version provided in builds later than 1322. The 

improved method preserves the original data and merges this with a new form of generated gap fill data. The original 

method could lead to excessive blurring of data, especially when required to be used more than once and often could 

not fill in all the gaps. 

3 Edited several older macros that recorded version as ‘1.00’, when it should have been ‘4.00’. New macros in this build 

are recorded as ‘4.01’.  

4 Enabled Cut and Combine in the Macro Editor to utilise the ‘Pasted Dummy replaces data’ check box setting when the 

‘Combine Function’ is set to ‘Paste’. This allows you to Paste without dummies replacing data. 

5 Updated Zero M Ttraverse in the Macro Editor to include the new facility described above in Processing Menu that 

allows you to apply start and end settings that limit the regions over which Zero M Traverse is applied. 

6 Fixed an issue with Zero M Traverse macros where Thresholds did not work correctly.  

Help Menu 

1 New form layout to include new PDF files that can be viewed. 

2 Help PDF documents for all forms, including Edit, Process and Tools, have now all been completed and revised. They are 

accessible by clicking on the  button on each form. Collections of these Help PDFs, grouped as: General Help, Process 

Help and Tools Help, can also be selected in the PDF Help documents form for viewing. 

 
 
Build 1322 Notes  
 
Documentation 

1 Documentation has been revised and restructured. 

Environment and Options 

1 Changed the design of the rotate data buttons to the right of the north symbol. The clockwise and anticlockwise curled 

arrows make their function clearer. 

2 Changes to Environment Options: General Tab adds View Help Processing Basics for Resistance, Gradiometer and 

Magnetometer data options along with View Calculator option, Download Tab adds Grid Names Table Line Colour 

options, MasterGrid Tab adds Grid Line Colour options. 

3 Changes to Graphics Options: General Tab adds Desktop Image Save and/or Print options with an associated Windows 

Text Scaling option. 

4 Changes to Process Options: Clip. Search/Replace & Clipboard Tab adds options to provide single click paste from the 

clipboard to the Add, Divide and Multiply processing form value fields – this allows you to tailor operation with the in-

built Calculator. 

5 Changed SD in the Data Information panel form to 1 SD. 

6 Changed the source location of the Spanish Mission .gan files from Export to Import and the manual updated to reflect 

this. 

Graphics View 

1 The palette selection has been expanded with the addition of 8 new palettes and renaming of one. This includes a 

special “Climate Temperature 1850-2019” palette which, although it has been added mainly as a reminder of the 

climate crisis, actually does produce some interesting and possibly informative contour like results, especially for 

resistance data. Two palettes, one with two shades of grey and a red top, the other with one shade of grey and a red 

top can, when used with appropriate plotting parameters, display data at 1SD, 2SD and 3SD significance compared to 

the SD of noise measured in a quiet area. 

2 Opacity is now saved and reloaded correctly in v 4.02 of animation files. 

3 A button has been added to the Animation control panel to allow you to hide the Animation control panel and restore it 

by pressing the Space Bar, giving more room for the image. 

File Details View 

1 Fixed a problem whereby a MasterGrid would not always be found for display in File Details View. 

Graphics Menu 

1 An image of the desktop can be either saved and/or printed by clicking on the ‘Save and/or Print Desktop Image’ button 

on the general toolbar or from the Graphics Menu. Images can be saved as jpg, bmp, png, tif and gif. A form appears 

that allows you to choose to save and/or print. In your Windows settings, if you are using a size of text etc. other than 

normal 100% (see Windows Settings, “Scale and layout”), then you should set a matching size on the form so that the 

desktop image is correctly saved or printed. You can save this setting in Options for the next time you come to use this 

facility. 

File Menu 

1 Changes made to the MasterGrid and InputNames grid line colours – different shades can be set in Options. 



2 Added a trap for invalid data when composites are loaded which also reports the number of invalid data points. 

3 Added a trap for bad data when using import in Z format, which also gives the position of bad data. 

4 Added specialised import to handle Frobisher XYZ comma separated variable files, which are stored on an SD card. This 

allows import of resistance (TAR-3) data and gradiometer (DFG-1) data. The Input Template takes into account the fact 

that these instruments have X and Y swopped relative to the directions normally expected in Geoplot 4, so, providing 

you enter the Mapping details, as specified on the form, then this taken account of, and the data is automatically 

rotated 90 degrees internally so that the first traverse is horizontal, in keeping with the Geoplot approach. Grids can 

subsequently be assembled into composites using a mesh definition with this orientation. The Input Templates also 

take into account the different dummy values used in the resistance (2047.5) and gradiometer (999.9999) instruments. 

You must ensure you enter Mapping details according to the instructions given on the form, in red 

5 Extra Source Grid sizes of 1m have been added to the Composite Input Template, for both Grid Length and Grid Width. 

This allows the import any data set size as composite, but one where the source grid size will be 1m x 1m. Note that 

having a 1m x 1m grid would limit some process functions that are grid dependant in the area they act upon. However, 

it is possible to subsequently edit the source grid size, either using the Edit menu or by using the button in the Data 

Information panel on the right of the screen. Therefore, with some geometries, for example if one dimension is exactly 

divisible by 4, 5, 10, 15 etc, this may enable some sensible grid dependent large area processing to be done. Or, even if 

not exactly divisible, it might be useful for some localised Destagger or ZMT processing of a small area, for example. 

Edit Menu 

1 Fixed a problem when the number of data edits exceeded 45. 

2 Changed the Edit Source Grid Size button symbol on the Control Panel, Data Information section to match the “3 grid” 

symbol used on the Edit menu. 

Processing Menu 

1 Added a message to the Despike function form to aid removal of spikes in the data at the edges: “To remove spikes at 

the edge of a grid or composite use Radius values of X=2, Y=2". 

2 Fixed a bug with the Clip process function. If Clip Minimum and Maximum values were set using SD parameters for 

resistance data, then the mean of the data set was not taken into account, resulting in incorrect clipping.  

3 Fixed a bug in the Statistic form where the information text box colours did not always change back from green to 

white after clicking on the field to copy data to the clipboard.  

Tools Menu 

1 A Calculator tool has been added that provides a convenient way of making simple calculations during processing and 

capitalises on special one-click copy and paste operations possible in various parts of Geoplot. It can save several 

keyboard clicks and mouse highlight movements, compared to using the Windows calculator. The calculator is in the 

bottom right-hand corner and can be hidden or shown by using the Tools Menu or clicking on the Calculator icon on the 

General Toolbar. Environment Options controls whether it is shown at start-up or not. You can enter values for 

variables A and B and then perform Addition, Subtraction, Multiply, Divide, raise A to the power of B or calculate the 

square root of A. Use the result in various process functions such as Add, Divide or Multiply, either entering the result 

manually in these functions, by single clicking on the field or by copy and pasting from the result text box into the 

function form 

2 Added a reminder to the ‘Create Survey Perimeter Outline’ form that the data must use 2047.5 as a dummy reading. 

Help Menu 

1 On the Help menu, the items shown in the View Manual (PDF) form have been simplified, pending addition of future 

documents. Three Processing Basics PDF’s have been added for Resistance, Gradiometer and Magnetometer data, 

which summarise guidance on how you should consider processing such data. The Help menu has also been extended 

so you can also click on it to view the same information as floating Help forms in the style of the Scratchpad. These 

forms can be resized to fit within the screen and used as a reference when processing. The content has been updated 

and revised, compared to earlier help information. The content can be found in the c:\gp400\Help folder as simple text 

files: HelpResistance, HelpGradiometer and HelpMagnetometer. These can be edited by instructors if they wish to 

provide different information to students. Options, General Tab determines if these are displayed each time at program 

launch. 

 
 
Build 1205 Notes  
 
Environment 

1 Created new button icons for the Edit menu, Process Selection Block and Macro Editor to give greater clarity. 

2 Fixed bugs associated with User Defined Import Input Templates. 

3 A file extension filter has been added to the Import form, allowing you to easier browse and select specific file types. 

4 The message associated with the Cancel button on the Grid Names form, used for downloads, has been expanded to 

avoid user confusion and concerns when leaving this form. 

5 Download of GPS data is not supported in this version so the Input Template setting ‘GPS Data Logged’, where you 

could previously (and erroneously) previously change the setting from No to Yes, has been disabled, pending code 

changes. 



6 A button is provided on the Data Information panel that places a summary on the clipboard. This can be copied to the 

Scratchpad for example. 

7 Several new options have been provided so the format of most of the Options files has changed, requiring new ones to 

be automatically installed with this code. 

8 Extensive revision of the Instruction manual which is now referred to as ‘Geoplot 4 Instruction Manual Summary’ and 

comprises this document. It has been expanded to 63 pages and now has a contents page and much more complete 

information on such topics as Download, Import and Macros, This summary can be shown as a PDF document in your 

PDF reader when selected from the Help menu. Provision is made for launching a full manual, in separate chapters, also 

from the Help menu. At present these chapters are incomplete but will be released in due course and sent to registered 

users as they become available. The PDF chapters will be: 

Contents, Chapter 1 – Introduction, Chapter 2 – Installation, Chapter 3 – Tutorial, Chapter 4 – Data Input, Chapter 5 – 

Additional Information, Chapter 6 – Processing Reference, Chapter 7 – Processing Examples, Chapter 8 – Trouble-

Shooting, Chapter 9 – Data Sheet, Chapter 10 – Installation Files. 

9 All form Help buttons have been activated. These now either show a second form, with brief help, or trigger a context 

sensitive PDF Help document to be shown in your PDF reader. Not all the process PDF Help documents are complete so 

for now these will just launch a standard template document. These will be released in due course and sent to 

registered users as they become available. In the mean-time please refer to the Geoplot 3 Processing Reference for 

further help. The PDF Help documents for completion are: 

Compress, Cut & Combine, Deslope, Despike, Destagger, Divide, Edge Match, High Pass Filter, Interpolate, Low Pass 

Filter, Median Filter, Multiply, Periodic Filter, Power, Randomise, Search & Replace, Spectrum Analysis, Standard 

Deviation & Variance Map, Statistics, Wallis Filter, Zero M Traverse 

Graphics View 

1 Extensive rework of the Process Block selection system on a graphics. This now gives much more precise and accurate 

control; it also constrains any selection made outside of the image area.  

2 There are now three sizes of handles on the Process Block selection rectangle which can be set in Graphics Options. The 

Normal size is used for routine desktop work. If using a touch-screen then the Large or Very Large handles can be used 

so a stylus or even a finger can be used to resize the rectangle 

3 The palette selection has been greatly expanded. There are an extra 11 new single colour palettes, and 13 new three 

shades of colour palettes. There is also a new grey/colour palette (grey23) with a compressed central grey section. The 

new single colour and 3 band palettes are designed for creating simplified plots that can be used as layers in 

Animations, aiding survey result interpretation when different survey results are overlain one another. 

4 Zoom-In To a Point and Zoom-Out From a Point are not properly working yet – for now they are disabled; instead use 

the normal zoom in / out to the level you require and then Pan. 

5 Fixed bugs with Trace and Relief Default buttons present in the RH Control panel. 

6 Improved operation of Trace X-Displacement and Y Expansion. However, please note that at present, when you set a 

non-zero X Displacement value and set Hidden Line to on, then the shadow cast by any spikes will not be correctly 

placed. 

Graphics Menu 

1 Shade and Trace Plot menu forms are now working and synchronised with the RH Panel, and vice-versa. 

2 A new Image Threshold Tool allows you to extract more information from an image, usually a grey scale, by setting a 

threshold level above which image information is displayed using a chosen palette colour, whilst below that level that 

part of the image will be typically white. This tool is useful for applying to radar images and the thresholded image can 

be subsequently used in the Animation as an interpretation layer. It can be used to give false colour to grey images as 

well. 

Process Menu 

1 The function of Zero M Traverse has now been extended to work with either Mean or Median as the Zero Measure 

which is subtracted from the traverse data. Both may be used with or without application of Thresholds. Thresholds are 

very useful for working in the presence of very strong features often given by ferrous features) or for preserving weak 

features running in the traverse direction. Least Means Square Fit can also be used with both measures. 

2 Added an ‘X Direction Traverses Only’ reminder to ZMT, FFT, Periodic, Destagger, Add (Alternate Traverses) forms. This 

is intended to act a reminder to observe correct data set orientation when applying these functions. 

3 The Median filter bug, present in the previous build, has now been fixed so there is now no X or Y shift. 

4 The Statistics function form that appears after you select a data block now has an option to save a summary of the 

statistics to the Windows clipboard. This can be pasted into the ScratchPad, Composite Notes or other locations that 

accept text. When you click on this button all the statistics fields will briefly turn green to indicate they have been 

copied. 

Tools Menu 

1 Fixed bug with GPS Gap Fill that shifted data by 1 in the X and Y direction. Also changed the algorithm so it now copes 

with a much wider range of data sets that have a mean of between +10000 and -10000. 

2 The Run Macro form is now adjustable in size and any new size is remembered. 

 

 



Build 1124 Notes 
 

Environment 

5 Print has now been completed for Graphics, History and File Details Views. See following sections for details. 

6 Options added for printing in both Environment Options (applies to History and File Details only) and Graphics Options 

(applies to graphics only). 

7 The statistics report form that appears after you select a data block now has an option to save a summary of the 

statistics to the Windows clipboard. This can be pasted into the ScratchPad, Composite Notes or other locations that 

accept text. When you click on this button all the statistics fields will briefly turn green to indicate they have been 

copied and a summary prepared. 

8 Bug fix – changed keyboard short cuts for Options to Alt+Shift+letter to avoid conflict with Alt-F and Alt-P menu access. 

9 Changed the action of clicking on the text box (on the right of the menu bar that shows the full file path of the current 

file loaded) so that this operation copies just the filename to the clipboard, discarding the other parts. 

10 Added MasterGrid, Animation and Edit Source Grid Size Help information. 

11 Added a setting for Export of XYZ-CommaSV data to allow insertion of a space before numbers to allow ArcGIS to 

correctly import the data. The preferred setting can be set in Export Options. 

 

 

Graphics View 

1 Shade and Trace plots can be printed either as scaled plots (e.g. 1:1000) or as sized plots (e.g. x2); scale can be selected 

from a drop down list or set to any specific value. Optionally File Information, Statistics and History can be printed out 

with the plot. Trace plots additionally have a Quality setting, Coarse, Medium and Fine, corresponding to the view seen 

at x1, x2 and x4 respectively. Apply caution when printing scaled Trace plots since, depending on the data set, chosen 

scale and dpi, some small horizontal sections of the image may be missing; when printed using sized plots Trace plots 

are always complete. If PDFCreator is used as the printer then the graphics can be saved as PDF files or as graphics files 

such as png where very high resolutions can be set, e.g. 2400dpi. 

2 Trace Save is no longer limited to just saving the LCD screen area - improvements to the Trace plot system allows saving 

of any off-screen areas, so the image can be saved at high magnification / resolution. Only the area of the trace plot is 

saved and images may generally be saved as jpg, bmp, png, tif and gif for use in publications. When transparency is 

turned on using the ‘T’ button, trace lines will be saved on a transparent background; when turned off the background 

will be white. Transparent images can only be saved as png or tif files since these support transparency whereas jpg, 

bmp and gif do not. 

3 Trace plots can now be panned as well as shade plots. 

4 A bug fix stops trace plot disappearing when clicking on the screen. 
File Details View 

1 A summary of both grid and composite file details can be printed. This can be either to a real printer or PDFCreator (or 

similar) to obtain a PDF document. Optionally, history can be printed out at the same time. 

History View 

1 The full history can be printed. This can be either to a real printer or PDFCreator (or similar) to obtain a PDF document. 

MasterGrid 

1 You can now click on an Export button to create a spreadsheet text file, with MasterGrid names separated by either 

tabs, commas or spaces. This can be opened in Notepad or Excel for further manipulation or use. 

 
 
Build 1072 Notes 
 
Environment 

1 New Splash screen at start-up. 

2 General bug fixes including restoration of Ctrl-C and Ctrl-V to compliment right click Copy and Paste operation. 

3 You can now single click on the text box (on the right of the menu bar) that shows the full file path of the current file 

loaded and this operation saves just the filename to the clipboard, discarding other parts; the text box will have a green 

background for half a second to indicate this has happened. This can be very useful for Save Image and Save Histogram 

when the file name is complex and you wish to incorporate that in the image name, e.g. “R_HPF10x10_ZMT_LPF1x1x6”. 

Normal Copy and Paste can also be used but this method extracts the filename more easily. 

4 Added buttons on the left-hand side of the General Toolbar for New Input Template and Open Input Template. These 

may not be displayed on narrow screen widths. 

5 The About form reports on additional installation file paths and file version numbers are introduced for grids, 

composites and input templates – these are no longer tied to the Geoplot version number. 

6 The distance scale bar now changes format dynamically with the number of divisions being appropriate for the scale 

and magnification. A report of the division size is given below the scale bar. Fixed reported scale bar distance at x5 

magnification. 

Data View 



7 Editing of data in Data View is now working. Instructions are added to the Help button. 

8 Bug fixes to Data View and improvements to functionality, especially with regard to updating after process applications 

etc. 

9 In Environment Options the Data tab has the addition of a threshold setting above which the Data View graphic does 

not update after processing to avoid delays with large data sets. 

File Details View 

10 Bug fixes in the File Details View so that the information for grids and composites displays correctly. 

Graphics Menu 

11 Animation overlays now supports proper support for transparency for png and tif images, allowing improved quality of 

data set comparison. 

12 The palette number has increased from 28 to 33 – the additions include palettes designed for Animation overlays, plus 

a black top palette. The palette selection order is changed slightly to provide better grouping; this involved some name 

changes. 

13 Histograms can now be saved, either using the Graphics Menu or by clicking on a small camera button just to the right 

of the histogram in the RH panel. 

 

 

File Menu 

14 Bug fixes to the Input Template system so you can now save templates for Non-Uniform Import as well as Gridded. User 

Defined templates have provision for entering more instrumentation details using blank text box for user definition. 

Templates are now recorded as version 4.02. 

15 Added download facilities for an FGM650 / FAB1 combination mounted on an MSP25 cart (non GPS for the moment). 

The handheld FGM650 / FAB1 combination is renamed. 

16 Expanded the Non-Uniform Import allocation matrix choices to 1x1, 2x2, 4x4, 8x8, and 16x16. The allocation matrix size 

controls how finely or coarsely the data will be re-sampled into Geoplot format. In Environment Options the Import tab 

allows you to set the default allocation matrix size. 

 
 
Build 1004 Notes 
 

Documentation 

1 The Build documentation has been extensively revised and restructured, not only with more detail on new features but 

also as a guide to new users. 

Environment and Options 

2 When you first launch this build of Geoplot a yellow background reminder form appears to set the decimal separator 

correctly on a computer – especially important for European users and import of data. 

3 Although it is past Easter Time an Easter Egg can be found somewhere in Geoplot 4.0 (Hint – you’ll need sounds to be 

on!). 

4 Changes to Environment Options: Data Tab adds Data View Window options, Import Tab adds Gridded and Non-

Uniform options, MasterGrid Tab adds Drag and Drop options, Sounds Tab sets whether a Quindar tone is made after a 

process function. 

5 Changes to Graphics Options: Animation Editor & Display Tab options extended. 

6 Changes to Process Options: Cut and Combine Tab adds an option for the Add Combine function behaviour for dummy 

readings, Clip & Search/Replace Tab added to set combo box dropdown order preference. 

7 Changes to Tools and Edit Options: Create Survey Perimeter Outline Tab added which determines how the outline is 

created and saved as an image. 

8 A red ‘O’ in a button on a form or the main screen reminds you there are Options associated with this element and if 

you click the button it takes you directly to the appropriate Options tab. 

9 A Rotate icon has been added to bottom of LH toolbar and the Horizontal Toolbar. 

10 Added example data sets for LiDAR import, Ferex import, Create Survey Outline Tool – see notes below. 

11 Added documentation for downloading RM85 Single Twin data as a download example. 

Data View 

12 The Data View has a small image of the data plus red rectangle which moves over the plot to show what area of data 

you are looking at (the view window size is adjustable). Editing of data is not yet implemented. Note that, at present, 

when a process function is applied this is not reflected in the data values you see. 

File Menu 

13 The MasterGrid form has been enlarged in size and is improved by the addition of drag and drop assembly of file names 

from a list. A check box determines whether grid names are removed from the list as they are dragged to the 

MasterGrid. You can alternatively add names manually as well as in earlier versions. A checkbox determines whether 

the notes from Grid 1 are added to the composite notes when it is created. 



14 Download has been extended to provide support for the RM85 / FAB1 / FGM650 handheld system. 

15 Imported data can be either gridded or non-uniform. Non-uniform import allows data to be imported from non-

Geoscan instruments such as Foerster Ferex multi-sensor arrays, Sensys MXPDA multi-sensor arrays (ASCII XYZ files) 

which have different sampling intervals to those used in Geoscan instruments - see example Ferex data below, left 

where the data sampling is every 10cm, and traverse interval 1m. Example non-GPS referenced Ferex data is provided 

in the directory Import_Data\JF_Foerster_Ferex.  

16 GPS referenced data can also be imported and processed as non-uniform data if it is supplied as an XYZ file with either 

UTM or northing and easting coordinates. Note that grid specific (e.g. ZMT) or line specific (e.g. Destagger) process 

functions will not yet work directly with GPS referenced data, though GPS referenced data that has also been collected 

on a gridded basis can have these functions applied first, as gridded data, then exported and re-imported as GPS 

referenced data. 

17 Import has been extended to include import of DSM and DTM LiDAR data from sources such as the Environment 

Agency Geomatics Survey Open Data. This can be further processed e.g. using HPF. An example file for import can be 

found in the Import_Data\LiDAR_DTM_2m directory. 

18 Fixed an error in Import which could occur if there was a mismatch between the version of Excel installed and expected 

or if Excel was not installed at all. 

 

Edit Menu 

19 The function Edit Source Grid Size was formerly available only in the File Details view, F8. This is now moved to the Edit 

menu and there is also a button on the Control Panel, next to the report of Source Grid Size. Can only be used when a 

composite is loaded. This can be used to isolate, for example, the top half of a grid for Destagger or ZMT application but 

did not want to apply it to the bottom half. Once done edit the source grid size back again. 

Graphics Menu 

20 Animation has been given a major overhaul. The animation can be paused at any convenient point, run forwards or 

backwards either continuously or in single steps. The opacity of any selected overlay image can be interactively 

adjusted to help in understanding data sets, their spatial relationship, complementary nature and to develop an 

interpretation from a variety of sources - including resistance, magnetics, GPR, LiDAR, topography, EM etc. Images can 

be .jpg, .bmp, .png, .gif, or .tif in any combination. Now up to 9 images can be selected for overlay on the animation and 

each image can be turned on or off and its ordering position relative to other layers changed. 

Processing 

21 Destagger has been extended so it can be applied to individual grids, all grids individually or the whole composite. The 

latter addition can help prevent edge artefacts.  

22 Cut and Combine Add now has a check box for determining action for dummy readings. The default action is for dummy 

readings to be ignored when adding data sets. If the checkbox is ticked then an added dummy reading will replace data. 

23 Search and Replace has additional drop down values of ‘+Mean/2’ and ‘+Mean/5’ in the ‘From’ and ‘To’ fields.  

24 Fixed bug in process area selection snap to grid. 

Tools Menu 

25 Added Convert Grid to Composite tool – useful for bypassing the MasterGrid approach to creating a composite if only a 

single grid has been downloaded. Useful also to apply some processing functions e.g. FFT to a specific grid (and then 

use Convert Composite to grid – see next). It appears in the menu or on the top toolbar. 

26 Added Convert Composite to Grid – useful if you have previously used Convert Grid to Composite to apply some 

processing functions and then want to change it back to a grid, perhaps for inclusion in a MasterGrid. It appears in the 

menu or on the top toolbar. 

27 Added Create Survey Perimeter Outline tool – this generates an outline of the survey area (transparent if required) 

which is useful for generating interpretations and reports. The example composite data provided in the Castle directory 

can be used to try this tool out. 

28 Added GPS Gap Fill tool which can be used for completing imported non-uniform GPS referenced data. 

29 Changed the Macro Editor Icon. 

30 Extended Swop Adjacent Traverses to composites as well as grids. 

31 Fixed bug in Swop Alternate Traverses for grids. 
 
 
Build 844 Notes 

1 Fixed a bug when downloading Parallel Twin data. The bug could occur if Sample and Traverse Interval were different or 

the grid width and length were different. For example, with a 20m x 20m grid if Sample Interval = 1m and Traverse 

Interval = 0.5m then this equated to 20 readings in the x direction and 40 in the y direction, resulting in banding in the 

second half of the downloaded grid (if Sample interval was also 0.5m then no such problem would occur since this 

would equate to 40 x 40 readings). 



2 Fixed a bug which occurred when trying to use the Open button on the horizontal toolbar when no data is loaded. The 

button now works. 
 
 
Build 834 Notes 

1 Spectrum and Periodic Filter have been added.  

2 Export has been added which provides formats: Z, XYZ (comma, tab, and space), Spreadsheet (comma, tab), Geosoft, 

Surfer (ASCII) and Grass for GIS. 

3 Import has been extended to include Spreadsheet (comma, tab and Excel). Files may be imported singly or in a batch. 

Prefix and Suffix fields are provided to modify file names. Excel import requires Excel to be installed on the PC.  

4 Animation has been added, along with the addition of image overlay tools that support archaeological feature analysis 

and interpretation based on multi-method geophysical survey. Block selection of images in ascending or descending 

order speeds up the creation of animations. In addition up to 4 images can be selected which can be superimposed 

over the animation - each image can be turned on or off and has adjustable opacity (the number of images will be 

extended to 10 shortly). The animation can be paused at any convenient point, or left running, and overlay images can 

be interactively adjusted to help in understanding data sets, their registration, complimentary nature and 

interpretation from a variety of sources - these can include resistance, magnetics, radar, LiDAR, topography, EM etc. 

Images can be .jpg, .bmp, .png, .gif, or .tif; Geoplot 4.0 can be used to prepare the data and generate suitable images 

using its Save Image As capability. To create an Animation first use the Browse button to add files to the image list on 

the left. An image preview can be made by clicking on a file name. Files from this list can be added, inserted or deleted 

from an animation list on the right, either singly or in blocks of ascending or descending names. If you intend to add file 

names in blocks only add names to the left-hand list at first that will be part of the block. It can be useful to use both 

the ascending and descending buttons to create an animation list. Further images can be added to the Image list and 

can be individually selected for addition to the Overlay Image list. Click Start Animation to commence viewing all the 

image files. If desired, an animation does not have to be created and just the Overlay Images can be used in the next 

view. The animation display form allows you to control the speed of the animation, which files are used as overlays and 

their opacity adjusted. Default speed and opacities can be set in Graphics Options. See the latest Geoplot 4.0 data sheet 

for examples of animation use. Example images from radar, resistance and gradiometer for the Spanish Mission 

Settlement survey are provided with the Geoplot 4.0 installation for you to experiment with. Note that animation and 

overlay images must all be in the same directory. 

5 A ScratchPad form has been added that can be used to make notes during a Geoplot session - the form can be resized 

and repositioned. Any text is saved when Geoplot is exited and is then reloaded when the program restarts to act as a 

reminder. Tab and Enter may be used. Closing or cancelling the form does not lose any information - use the Clear 

button to delete all the text. You can use the 'Add Text to Comp Notes' button to save the text with composite file 

notes. Examples of use include noting block statistics (click on Statistics Form value to place in Clipboard then paste into 

the Scratchpad) or noting block coordinates ready for entering into Cut and Combine - values can be copied and pasted. 

The name of the current file loaded can be copied and pasted here from the menu bar. Reminders for present or future 

processing steps can be recorded. Process History can be copied here. Any ScratchPad text can be pasted in to the 

Composite Notes area if enabled - for example recording the logic behind specific steps taken to correct unusual survey 

defects. Whether it shows at start-up can be controlled in Environment Options. 

6 A facility has been added to Trace plot which allows you to show any existing Shade Clip plot in the background, 

underneath the traces. This is activated by clicking on the ‘S’ button in the graphics control panel. To change the shade 

plot navigate back to Shade plot, change the plotting parameters and then return to Trace plot. 

7 Trace line colour can be set directly by clicking on the ‘L’ button in the graphics control panel; the button changes 

colour to reflect Trace line colour. 

8 Trace plot quality has been improved, though at the slight expense of speed. 

9 Separate ‘Open Grid’ and ‘Open Composite’ menu items have been added to the File menu, including short cuts 

Ctrl+Shift+O and Ctrl+O respectively, that allow Open to immediately show contents of the last grid or composite 

directory used, making for faster file selection. 

10 Ctrl-Z (Undo) action has been added to all process forms. 

11 Grid sizes 60m and 80m have been added to the download system which may prove useful for MSP25 surveys. 

12 A button to allow editing of Grid Source dimensions has been added to File View. This can be useful if you wish to use, 

for example, Destagger over a smaller section (e.g. 5m) than source grid width would normally dictate. Once you have 

applied the process function you can reinstate the Grid Source dimension. 

13 A report of survey area in hectares has been added to the File View for composites – this has values for area including 

dummy readings and area without dummy readings. These values can be used for survey reports. 

14 The tool ‘Invert Traverse Mode’ has been extended to Composites as well as grids. 

15 Cut and Combine now has a checkbox for determining Paste action for dummy readings. The default action is for any 

pasted dummy to replace existing data but this can be turned off to preserve any original data value if desired. In 

addition you can now use the mouse to look at coordinates of graphics areas whilst the Cut and Combine form is active. 

16 The macro ‘Stripe Defect Removal in Non-Bipolar Data’ has been added as a function to the Tools menu.It remains also 

present as a Macro. 



17 The tool Flip Vertical has been added for grids and composites, joining Flip Horizontal. 

18 Cut and Combine has been restored to the macro Editor now that it is working properly again. 

19 The Macro Destagger pattern has been extended to match that of the normal process function. 

20 Environment Options has been extended to allow you to make macros show as just a short summary in process history, 

rather than a full list of process functions and parameters used. 

21 Environment Options has been extended to allow default preferences for Import and Export. 

22 The Merge Composite tool has been completed and includes Tools Options settings. 

23 Fixed a problem loading Geoplot 2.02 grid data. 

24 Fixed a problem with the data value reported on the status bar as the mouse pointer is moved over an image – this 

includes Pan. 

25 Previous file paths are now remembered properly. 

26 Have investigated the Parallel Twin dump bug that some users have reported when traverse interval is 0.5m. However 

tests do not indicate a problem. Further feedback would be appreciated. 

27 Changes have been made to the Quick Entry form used in download to allow suggested suffixes to be changed. 

28 The Geoplot 3.0 manual and Geoplot 3.0 Process reference have been added to the PDF Help form – in the absence of a 

formal GP4.0 manual we hope this guidance will help in the short term since in most cases functionality is the same as 

in 4.0. 

 
 
Build 690 Notes 

1 When the program first starts a new Help panel appears in the centre of the screen. This behaviour can be turned off in 

Options, Environment, General, or at the base of the panel. The panel will be of use to new users and can be resized 

and positioned in the corner of the screen for reference. The panel is incomplete at the moment and some screen shots 

are now out of date. 

2 Some help panels have now been added to the process function forms, EG ZMG – the original blue Help button is 

replaced by a yellow background help button in cases where new information is available. Also Help and PDF buttons 

have been added to the horizontal toolbar – these have limited functionality at the moment but PDF can be used to 

display this document and the latest data sheet for now. 

3 There has been a major update of Environment Options (new tabs include Import, Export and Macro), Graphics Options 

and Tools Options (which now becomes Tools and Edit options). Because of cumulative effect of these updates and new 

additional files this new release will require a un-install of the previous code and re-installation of new code. 

4 When colours in Graphics options are changed, clicking the Apply button immediately updates the display. 

5 There has been a redesign of several toolbar button icons, including Import, Export, Multiply and Add to make them 

more streamlined. 

6 Wallis Filter is now working. 

7 A Divide process function has been added. As with many other process functions either a number can be specified or 

the combo box can be used to select statistical values such as 1SD, Mean etc. 

8 The Destagger process function has been extended so that 2-5 lines can shifted at a time, useful for multi-sensor 

magnetic arrays such as Ferrex data. 

9 Undo and Check Process effect buttons have been added to most process function forms making it easier and quicker 

to experiment with different parameters on form. Remember that this is a single level undo. 

10 Import has been extended to cater for data collected at grid edges, IE starting at 0, 0, rather than standard Geoplot 1, 1. 

This collection procedure, typical of Ferrex, CMD and other EM data, results in, for the example of a 40m grid with 

sampling of 1m, a resultant data width of 41 readings not the normal Geoplot 40 readings. A radio button lets you 

specify the sampling pattern and allows Ferrex, CMD and other EM data to be imported. 

11 View change arrows have been added to the top horizontal toolbar to compliment the View menu and functions keys 

F5, F6, F7 and F8.  

12 Transparency buttons have been added to the RH control panel so that when an image is saved dummy readings can be 

saved as transparent areas for Shade plots – however trace plots can only be saved with a transparent background for 

now. 

13 Trace plot quality is greatly improved, especially for sparse data sets. Most plotting parameters on the RH panel for the 

two Trace modes are now working include Resolution, Units, Clip levels and Trace View, along with a button to turn 

dummy trace lines on and off and a button to set the background to transparent. X Displacement is not yet working. Y 

Expansion (+/- values) is partly working – at the moment the plot is not central and border, grid lines, numbers and 

names are not placed correctly. The data set mean is subtracted for trace plots so that non-bipolar data (EG resistance) 

appears centrally. Trace border colour and Trace dummy line colour can be set in Graphics Options. The background 

colour of trace plots can only be transparent for the moment (ignore the button to set background to transparent) so 

images can only be saved as png, tif (transparent background), not jpg, bmp, gif which require a solid background. 

Transparent images can be overlain on corresponding shade plots in publishing documents. 

14 Grid Numbers and Grid Filenames can now have a white background, set in Graphics Options. Positioning is now 

correct. Grid Filenames position can now be offset upwards by one line so it does not overlap Grid Numbers – set in 



Graphics Options. A warning that grid names will be misleading is given if data is rotated and grid names are displayed – 

the message disappears if data is subsequently rotated back or round to the original position. 

15 We have removed various menu and toolbar items which will now be implemented in version 4.1 after the initial 

release: Keyboard Input, Data Edit, Create New Palette, Select Graphics Area, Merge MSP Composites, Create Pseudo-

Section. 

16 Work has started on implementing the outstanding items we intend to include in this first release: Merge Composites, 

Export, Periodic Filter and Spectrum, Animation. Plus of course removing remaining bugs and tidying up functionality. 

 

 
Build 614 Notes 

1 Import is now working, including file scan facility. 

2 Pan working although Zoom In To Point and Zoom Out From Point still not working correctly. 

3 Border Display button added to horizontal toolbar. 

4 Limited print capability added – History view prints OK. 

5 12 new palettes added (28 in total available) and all palettes renamed for better structuring. 

6 Relief plots now working including animation. 

7 Block select now tracks when you zoon in and out. 

8 Macro system now complete: Define Macro Maps working, added Divide, Sum Macro Maps, Multiply Macro Maps 

macros but removed Cut and Combine macros. 

9 More macros developed and added to the installation. 

10 Trace plot greatly improved – now zooms in and out though still only front view available and ideally requires sampling 

interval of 0.25m or finer for a good plot. Trace scale bar working and tracks parameter entry. 

11 Trace Clip graphics now working. 

12 Compress graphics now working 

13 Grid lines, User grid lines and selection block all now align with one another. 

14 Grid filenames can now be displayed though positioning needs to be improved. 

15 Display of RH panels order changed so that Trace and Shade sit next to one another. 

16 Replicated title bar file information on a label on the menu strip – easier to read and can also be copied for inclusion 

elsewhere. 

17 Added ‘Add (Alternate Traverses)’ tool to menu. 

18 Microsoft.VisualBasic.PowerPacks.Vs.dll added to installation. 

19 Added distance scale and north symbols to the installation image folder for publication use. 

 
 
Build 528 Notes 

1 “Create Blank Composite” is now working. 

2 Cut and Combine fully working now – the default combine function is now Paste, not Subtract. 

3 A “Check Effect of a Process Function” button added to the horizontal toolbar and also function to the process menu 

(identified by a delta symbol). This replaces, and is more direct than, the special mode in Cut and Combine used for 

looking at the effect of processing – new data is subtracted from original data leaving just the difference. Once you 

have finished with this graphic click the delta symbol again to restore the pre-check processed data. The normal Undo 

state is unaffected. 

4 Removed Map Reference field in composite view – this can be added in notes instead. 

5 Changed default installation colour and width for final selection box. 

6 Have made ‘Reload’ inactive when new data has just been loaded. 

7 Median history now updates correctly. 

8 Extensive parameter entry checking in process function forms. 

9 Grid numbers can now be displayed. 

10 User grid can now be displayed. 

11 Added “+Mean/5” option to the Search and Replace process function – this is used in a Despike/data correction macro 

for MSP25/40 carts. 

12 Several new macros have been added including a range of contour macros which aid in overlaying gradiometer data 

over resistance data when used with Cut and Combine. 

 
 
Build 500 Notes 

1 Changed Macro Run and Macro Editor button image designs on the horizontal toolbar (and menus) so they are easier to 

locate quickly (green play triangle and stacked rectangles respectively). 

2 Test Macro and Undo Test buttons have been added to the Macro Editor form so you can now develop macros without 

leaving the form. The Undo is a single level. 

3 Fixed a bug with Macro Editor Delete Line. 



4 Undo now works for grids and composites; it is a single level. If a macro has been used then Undo removes all functions 

associated with the macro. [A bug has just been spotted in that Reload is still active even if changes have not been 

made to data. If you select Reload in these circumstances you will see a message saying “The current processed data 

will be lost if you Reload data. Proceed with Reload ?”. Click either OK or Cancel to clear the message. The bug does not 

cause any problems]. 

5 Changed the name of the floating form “Latest Short History” to Latest History – Floating. This form can be resized by 

the user and is now fully active. 

6 Process, Edit and Tools history is synchronised across all views: IE side panel ‘Latest History’, F7 History view and Latest 

History – Floating form. 

7 In Build 480 block selection code was improved. In the notes for that build it was reported that the default colour for 

the final selection box was bright green. However it is still set to orange so you should go to Options, Graphics, 

Selection Box Colour and set bright green. Also set the line width to 2 for a more distinct selection box. Or set your own 

preferences, 

8 On the Edit menu ‘Comment History Editor’, ‘North Direction’ and ‘Units’ are now working. 

9 Most recently used files (MRU) on the File menu is now working. 

10 Fixed resizing bug for the history view. 

11 Fixed bug whereby raw grid files could be saved with the same name after application of a Tools or Edit function. Now 

you will forced to choose a new name as was the case for Geoplot 3. 

12 Added a second report of the current file open on the main menu strip. This is much easier to read than if Geoplot 4 is 

used on a PC with a dark desktop background. 

 
 

Build 480 Notes 
1 Improved block selection code which should now clear the block when you load new data (though it is still not perfect). 

The initial selection box is now orange with the final colour being set by Options, Graphics, Selection Box Colour (by 

default bright green). 

2 Also Fixed the block select snap-to-grid icon report on bottom right hand corner. 

3 Process block now remembered when swopping between processes. 

4 Progress bar code added to many areas where speed feedback is required – process functions and open/save. 

5 Shift extended to X and Y – Y can be used to compensate for slight Interpolate shift as an interim measure. 

6 MasterGrid bug sorted so extra dummy grids are no longer added on accidentally to a created composite. Please let me 

know if you experience any problems with Mastergrid now (problem details required though !) 

7 Example Radar images changed from bmp to jpg though no animation code available yet. 

8 Close Grid/Composite removed from File menu. 

9 Several process function history reports improved including LPF, Compress. 

10 Macros now add their name to the history report and macro functions such as OpenMap1, SaveMap1 also appear on 

the history. 

11 I have noted that the macro function DefineMacroMaps does not work properly yet so please do not use this at the 

moment. 

12 I have noted that Cut and Combine, is not fully working in a way different to that outlined in build 461 instructions. It 

works OK providing you do not need to enter coordinates for the Combine To area (IE you are working with the same 

sized maps) 

13 Dump status improved in the feedback text box. 

14 Note added above regarding PC text size setting. 

15 Changed installer header name the desktop icon name from Geoplot to Geoplot 4. 

16 Updated Installation Preparation regarding XP IE NET 3.5. Changed the NET_Framework_Web_Installer program to 

dotNetFx35setup for use with XP. 

 
 

Build 461 Notes 
       1    First beta release. 

 


